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Accessing Data from the Web Interface

This chapter provides information about accessing Cisco Mobile Wireless Transport Manager (MWTM) 
data from the MWTM web interface by using a web browser. This chapter includes:

• Accessing the MWTM Web Interface, page 11-1

• Overview of the MWTM Web Interface, page 11-2

• Displaying the Home Page, page 11-8

• Displaying the Administrative Page, page 11-12

• Displaying Alarms and Events, page 11-30

• Displaying Summary Lists, page 11-31

• Displaying Reports, page 11-33

• Displaying Objects in a View, page 11-33

• Displaying RAN-O Historical Statistics, page 11-33

• Displaying CSG2 Real-Time Statistics, page 11-44

• Displaying BWG Real-Time Statistics, page 11-49

• Displaying HA Real-Time Statistics, page 11-62

• Displaying GGSN Real-Time Statistics, page 11-65

• Displaying PWE3 Real-Time Statistics, page 11-72

• Displaying TDM Real-Time Statistics, page 11-72

Accessing the MWTM Web Interface
The home page of the MWTM web interface is the first window to appear when you launch the MWTM 
web interface. 

To access the MWTM web interface, use one of these methods:

• Open a browser and enter http://mwtm_server:1774 in the Address field. (1774 is the default port.)

Note Accessing the MWTM web interface through a URL other than http://mwtm-server:1774 is not 
supported. 

• From the MWTM client interface, choose View > Web > Home.
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The MWTM Home page window opens in the browser window. For details about the Home page, see 
Displaying the Home Page, page 11-8.

Overview of the MWTM Web Interface
The MWTM web interface shows basic information about the events and objects that the MWTM 
manages.

Figure 11-1 MWTM Web Interface

The MWTM web interface shows:

Pane Description

Title Bar Shows:

• Mobile Wireless Transport Manager, version, and server name

• Managed networks (can be any combination of IPRAN, ITP, CSG1, CSG2, 
GGSN, BWG and/or HA)

• Logout (appears only if you enable user access; see Configuring User 
Access, page 2-1)

• Help—Click this link to access context-sensitive online help

• Preferences—Click this link to access preferences that you can change from 
the web interface (see Changing Web Preference Settings, page 5-20)

Location bar Shows where you currently are in the MWTM navigation tree.
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MWTM Web Interface Navigation Tree
You can easily navigate the features of the MWTM web interface by using the navigation tree in the left 
pane. By default, the navigation tree is sorted by alarm severity, with objects having the most severe 
alarms appearing at the top of the tree.

Note To learn more about alarm severity, see Chapter 9, “Managing Alarms and Events.”

To view detailed information about a selection in the navigation tree, click the item in the tree. The 
content area in the right pane shows details about the chosen item. A plus (+) or minus (-) just to the left 
of the item indicates whether the item has subtending items under its domain. 

The MWTM automatically updates the navigation tree when changes occur to discovered nodes or to the 
network. When any changes occur in the MWTM client navigation tree, the MWTM web interface 
reflects these changes in its navigation tree. For example, if you delete a node in the MWTM client, the 
MWTM web interface removes that node from its navigation tree. 

Note For information about the navigation tree in the MWTM client interface, see MWTM Client Navigation 
Tree, page 4-19.

The MWTM web interface navigation tree contains:

Navigation Tree In the left pane, shows a tree of information organized by categories (see MWTM 
Web Interface Navigation Tree, page 11-3).

Content Area In the right pane, shows detailed information about the object chosen in the 
navigation tree (see MWTM Web Interface Content Area, page 11-4).

Pane Description

GUI Element Description

Sort tree by name

Sorts all content in the navigation tree alphabetically by 
name. 

Sort tree by status

Sorts all content in the navigation tree by status, from the 
highest alarms to the lowest.

Home Shows links to MWTM client software, Cisco 
documentation, and information about the MWTM on the 
Cisco web (see Displaying the Home Page, page 11-8).
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MWTM Web Interface Content Area
The content area of the MWTM client interface is fully described in MWTM Client Content Area, 
page 4-19. That description also applies to the web interface. Additional navigational features that 
appear only in the web interface include:

• Customizing the Date Range, page 11-5

• Using the Toolbar, page 11-5

Administrative Shows MWTM system information including messages, logs, 
status, and properties (see Displaying the Administrative 
Page, page 11-12).

If MWTM User-Based Access is enabled, only users with 
authentication level 3 (Network Operator) and higher can see 
all options. Users of all other levels see only the System 
Information and System Status panes.

Active Alarms Shows alarms (see Displaying Alarms and Events, 
page 11-30).

Event History Shows information about the events delivered by the MWTM 
event logger and event processor for events that the MWTM 
event logger and event processor deliver for all objects in the 
current network view (see Displaying Alarms and Events, 
page 11-30).

Summary Lists Shows summaries of all objects that the MWTM manages 
(see Displaying Summary Lists, page 11-31).

Reports For ITP and RAN-O networks:

• Shows Event reports for RAN-O and ITP networks (see 
Setting an Alarm or Event Filter, page 9-18).

For ITP networks only:

• Shows ITP historical reports for a specified time period 
(see Displaying Reports, page 11-33). 

For RAN-O networks only:

• Shows RAN-O shorthaul and backhaul performance and 
error reports (see Viewing RAN Reports, page 12-75).

If MWTM User-Based Access is enabled, only users with 
authentication level 4 (Network Administrator) and higher 
can see the Reports menu.

File Archive Shows file archives (events and ITP reports). See Viewing 
Reports, page 12-6.

Tools Provides tools for launching CiscoWorks, CiscoView, Device 
Center, CSG Service Manager, and GGSN Service Manager 
(if integrated with MWTM). Also provides a search tool for 
Home Agent (HA) subscribers (see Tools, page 11-31).

DEFAULT View Shows a current list of nodes in the DEFAULT view (see 
Displaying Objects in a View, page 11-33).

GUI Element Description
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Customizing the Date Range

Some windows require that you select date ranges for generating historical graphs (see Displaying 
RAN-O Historical Statistics, page 11-33). Standard date ranges (for example, Last 24 Hours or Last 7 
Days) are available from a drop-down menu. However, if you want to customize the date range:

Step 1 Click the Customize Date and Time Range tool  in the toolbar of the content area. A dialog box 
appears. 

Step 2 Enter a:

a. Begin Date and End Date; or, select those dates by clicking the Calendar tool . 

b. Begin Hour and End Hour from the drop-down menus, if they are available.

Note The dialog box shows an error if the End Date is equal to or less than the Begin Date. Correct 
the error before proceeding. 

Step 3 Click OK to accept the date and time changes; or, Cancel to cancel this operation.

The MWTM web interface generates a report for the specified time period.

Using the Toolbar

Depending upon the object you select in the navigation tree, the web interface toolbar provides these 
tools and options:

Tool or Function Description

Last Updated Date and time the MWTM last updated the information on the page.

Page Shows where you are (page X of X total pages) and lists the total number of 
entries.

Refresh Forces a refresh of the current web page. Click this icon to refresh the current 
page.

Status Refresh Interval Allows you change the default refresh interval of 180 seconds. Enter a value 
between 180 and 900 seconds. 

Note Changes you make are temporary to the current page. Navigating 
away from the page sets the status refresh interval back to the default 
setting. To change the default setting, see Changing Web Preference 
Settings, page 5-20.
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Page Size Drop-down list of different page sizes (the number of table rows in the 
display). Click the drop-down arrow to select a different value. The value 
that you select becomes the default page size for all pages in the web 
interface. 

Caution Setting the Page Size to Unlimited may cause your browser to stop 
responding if the number of table rows is large.

The title bar displays the current page and total number of table entries.

> Advances the display to the next page of information.

>> Advances the display to the last page of information.

< Advances the display to the previous page of information.

<< Advances the display to the first page of information.

Modify event filter Opens the Event Filter dialog box. You can create a filter to display only the 
events in which you are interested (see Setting an Alarm or Event Filter, 
page 9-18).

Remove filter Applies or removes a filter that you created. 

Archived Link that shows only archived alarms or events. This link appears when you 
select Event History or Active Alarms in the navigation tree. It also appears 
when you click the Alarms tab or Recent Events tab for a specific object.

Caution In the Server.properties file, you can limit the number of rows in 
the archived events table with the MAX_ARCHIVED_EVENT
_DB_ROWS property. The default value is 200,000. Increasing 
this value can have severe impact on server performance and can 
cause the server to run out of memory.

Customize Date 
and Time Range

Opens the Customize Date and Time Range dialog box (see Customizing the 
Date Range, page 11-5).

Graph Series 
Editor

Opens the Graph Series Editor dialog box, which provides a check box for 
each shorthaul that is associated with the chosen RAN backhaul. To display 
a data series, check the check box. To hide a series, uncheck the check box.

If you uncheck all shorthauls and click OK, the graph shows the default 
series of shorthauls.

The MWTM displays no more than 12 series by default. To change this 
default setting, see Display Series Dialog Box, page 8-113.

Run Runs the report type for the chosen duration.

Export Exports the raw graph data to a report with comma-separated values (CSV 
file). You can save this file to disk or open it with an application that you 
choose (for example, Microsoft Excel).

Tool or Function Description
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Data Range Label that shows the chosen time range for the historical statistics.

Type Drop-down list of report types.

Duration Drop-down list of default time ranges. Select one of these options, then click 
the Run tool . To specify a nondefault time range, click the Customize 
Date and Time Range tool .

Output Type Drop-down menu that provides these options:

• Graph—Displays statistical data in graphs and tables

• Table—Presents statistical data in tabular format only

• CSV—Exports statistical data using comma-separated values

Pause Pauses the page refresh feature. Click Pause to disable the page refresh that 
would normally occur after the Status Refresh Interval. Click Pause again to 
re-enable the Status Refresh Interval.

Edit Notes Enables you to edit or add notes for events.

Slow Poller Interval Allows you to change the default slow poller interval of 60 seconds. Enter a 
value between 60 and 300 seconds. 

Note Changes you make are temporary to the current page. Navigating 
away from the page sets the status refresh interval back to the default 
setting. To change the default setting, see Changing Web Preference 
Settings, page 5-20.

Fast Poller Interval Allows you to change the default fast poller interval of 15 seconds. Enter a 
value between 5 and 60 seconds. 

Note Changes you make are temporary to the current page. Navigating 
away from the page sets the status refresh interval back to the default 
setting. To change the default setting, see Changing Web Preference 
Settings, page 5-20.

Reset Counters Enables you to modify the counter reset settings to one of the following: 

• Show counters since reboot

• Show counters since last poll

• Show counters since user reset

Launch Drop-down list of applications you can launch:

• CiscoView

• Device Center

After you choose the application, click the Run icon to launch it.

Severity Drop-down list of the severities of alarms or events. Severity can be Critical, 
Major, Minor, Warning, Informational, Indeterminate, or Normal. 

This drop-down list appears when you select Event History or Active Alarms 
in the navigation tree. It also appears when you click the Alarms tab or 
Recent Events tab for a specific object.

Tool or Function Description
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Displaying the Home Page
The MWTM web interface Home page provides access to MWTM client software, Cisco documentation, 
and information about the MWTM.

To access the Home page of the MWTM web interface, click Home under the navigation tree in the left 
pane. 

The content area in the right pane shows these GUI elements:

Change Severity Button to change the severity level of an alarm or event. 

To change the severity level, select one or more alarms or events by clicking 
the corresponding check boxes, choose a severity from the Severity 
drop-down list, then click Change Severity.

This button appears when you select Event History or Active Alarms in the 
navigation tree. It also appears when you click the Alarms tab or Recent 
Events tab for a specific object.

Clear Selection Link to clear the selection of one or more events or alarms. To select one or 
more alarms or events, check the corresponding check boxes. To clear the 
selection, click the Clear Selection link.

This button appears when you select Event History or Active Alarms in the 
navigation tree. It also appears when you click the Alarms tab or Recent 
Events tab for a specific object.

Toolbar for alarms and 
events

The web interface provides the same toolbar for alarms and events as the 
client interface. For full descriptions of these tools, see Toolbar Buttons, 
page 9-14.

Tool or Function Description

Pane GUI Element Description

Client Software Download Windows 
Client

Download Solaris 
Client

Download Linux 
Client

Browser Checker

Shows the download instructions for the:

• Windows client

• Solaris client

• Linux client

• Information about the browser and screen display

For details, see Downloading the MWTM Client from the 
Web, page 11-9.
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Downloading the MWTM Client from the Web
You can access the MWTM client installation software for Linux (unsupported), Solaris, and Windows 
from the MWTM web interface Home page. This access is useful if you do not have the CD-ROM, or if 
you prefer to download the software by using your web browser. Once you have downloaded the MWTM 
client installation software to your workstation, you must install the software on your local system.

For more information about installing the MWTM client software by using a web server, see the 
following chapters in the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1:

• “Installing the MWTM on Solaris”

• “Installing the MWTM on Windows”

• “Installing the MWTM on Linux” 

Downloading the Solaris Client

To access the MWTM Client for Solaris page, select Download Solaris Client.

The web interface shows the supported Solaris versions and instructions for downloading the Solaris 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1 for a detailed 
procedure.

MWTM on 
Cisco.com

MWTM Home Page

Engineering Software 
Updates (FTP)

MWTM Software 
Download Page

Latest MWTM 
Documentation

Shows hyperlinks to:

• MWTM information on the Cisco web

• Software updates provided by Cisco Engineering

• MWTM software download from Cisco.com

• Most recent versions of MWTM documentation

For details, see Accessing Software Updates and Additional 
Information, page 11-11.

Documentation Help Home Page

User Guide

Install Guide

Release Notes

Frequently Asked 
Questions

MWTM Server Help 
Command

Shows: 

• Online Help system for the MWTM

• PDF versions1 of the:

– User Guide for the Cisco Mobile Wireless 
Transport Manager

– Installation Guide for the Cisco Mobile Wireless 
Transport Manager

– Release Notes for the Cisco Mobile Wireless 
Transport Manager

• HTML version1 of the FAQs

• CLI output of the mwtm help command

For details, see Viewing the MWTM Technical 
Documentation, page 11-12.

1. To access the latest versions, go to the parent index for Cisco MWTM user documents: 
http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html

Pane GUI Element Description
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To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.

Downloading the Windows Client

To access the MWTM Client for Windows page, select Download Windows Client.

The web interface shows supported Windows versions and instructions for downloading the Windows 
setup program. After downloading the setup program onto your desktop or other Windows directory, 
double-click the setup.exe icon to start the setup program and launch the installation wizard. See the 
Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1 for detailed procedures.

To start the client after installation, launch it from the Windows Start menu or double-click the MWTM 
Client icon on your desktop.

Downloading the Linux Client (Unsupported)

To access the MWTM Client for Linux page, select Download Linux Client. 

Note The MWTM does not support the MWTM client for Linux. Use the MWTM Linux client under 
advisement.

The web interface shows the supported Linux versions and instructions for downloading the Linux 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1 for a detailed 
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.

Checking Your Browser

MWTM 6.1 supports the following browsers: 

1 The first time you attempt to connect to the MWTM server using Firefox 3.0, you must must add an exception 

to allow the connection. See the MWTM 6.1 Release Notes for more information. 

Note Opening the MWTM in an unsupported browser generates a warning. Also, if JavaScript is not enabled, 
the MWTM web interface cannot function.

Operating System Supported Browsers

Windows • Internet Explorer 6 

• Internet Explorer 7 

• Firefox 3.01

Solaris 9 
Solaris 10 

• Firefox 2.0

Red Hat Enterprise Linux AS 4.0 
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To check your browser and screen settings, select Browser Checker. 

The Browser Checker window contains:

Accessing Software Updates and Additional Information
You can access this information about the MWTM from the MWTM web interface Home page. To:

• View information about the MWTM or any other Cisco product available on Cisco.com, select Cisco 
Home Page.

• Read Cisco literature associated with the MWTM, including product data sheets, Q and As, and 
helpful presentations, select MWTM Home Page.

• Access software updates for the MWTM from Cisco.com for FTP, select Engineering Software 
Updates (FTP). The Cisco Systems Engineering FTP server page appears.

Pane or Field Description

Browser Information:

Browser The name and version of the browser you are using. For example, Firefox 
1.5.0.9.

Browser User Agent Text string sent to identify the user agent to the server. Typically includes 
includes information such as the application name, version, host operating 
system, and language.

Platform The platform type. For example, Win32.

Cookies Enabled Whether you have cookies enabled on the browser (Yes or No). 

Javascript Enabled Whether Javascript is enabled (Yes or No).

AJAX Component The Asynchronous JavaScript and XML (AJAX) component sends 
asynchronous HTTP update requests. The MWTM web application is only 
accessible to web browsers that have an AJAX component enabled. 
Typical values include XMLHttpRequest (for Mozilla-based browsers) 
and MSXML2.XmlHttp (for IE 6).

Screen Information:

Size Resolution of the display; for example, 1024 x 768. 

Color Depth Depth of the color display; for example, 16. 
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• Access software updates for the MWTM from Cisco.com, select MWTM Software Download 
Page. The Software Download page for the MWTM appears.

• Access the most recent versions of customer documentation for the MWTM, select Latest MWTM 
Documentation. The Cisco Mobile Wireless Transport Manager documentation page on Cisco.com 
appears. From this page, you can view the latest versions of MWTM release notes, installation 
guides, and end-user guides.

Note If you cannot access Cisco.com from your location, you can always view the customer 
documentation that was delivered with the MWTM software. See the “Viewing the MWTM 
Technical Documentation” section on page 11-12.

Viewing the MWTM Technical Documentation
From the MWTM web interface Home page, you can view this MWTM technical documentation. To 
view the:

• Entire Cisco Mobile Wireless Transport Manager Help System, select Help Home Page.

• Entire User Guide for the Cisco Mobile Wireless Transport Manager 6.1 as a PDF file on the web, 
using the Adobe Acrobat Reader, select User Guide (PDF).

• Entire Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1 as a PDF file on the 
web, using the Adobe Acrobat Reader, select Install Guide (PDF).

• Entire Release Notes for the Cisco Mobile Wireless Transport Manager 6.1 as a PDF file on the web, 
using the Adobe Acrobat Reader, select Release Notes (PDF).

• Frequently Asked Questions (FAQs) about the MWTM, select Frequently Asked Questions.

• Syntax for every MWTM command, select MWTM Server Help Command.

Caution These PDF versions of technical documents might not be the latest versions. For the latest versions, go 
to: http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html.

Displaying the Administrative Page
The MWTM web interface Administrative page provides access to MWTM system information, 
including messages, logs, status, and properties.

To access the Administrative page of the MWTM web interface, click Administrative under the 
navigation tree in the left pane. The right pane displays the information indicated in Table 11-1.

Note If MWTM User-Based Access is enabled, only users with authentication level 3 (Network Operator) and 
higher can see all options. Users of all other levels see only the System Information and System Status 
panes.
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Table 11-1 Administrative Page Information

Pane GUI Elements Description Reference

System 
Information

• README

• (ITP only) 
ITP OS README

• (IPRAN only) 
IPRAN OS 
README

• (mSEF, CSG1 only)
CSG1 OS 
README

• (mSEF, CSG2 only)
CSG2 OS 
README

• (mSEF, GGSN only)
GGSN OS 
README

• (mSEF, HA only)
HA OS README

• (mSEF, BWG only) 
BWG OS 
README

• MIBs

• README.txt file

• MWTM-OS-Info-ITP file

• MWTM-OS-Info-IPRAN 
file

• MWTM-OS-Info-CSG1 
file

• MWTM-OS-Info-CSG2 
file

• MWTM-OS-Info-GGSN 
file

• MWTM-OS-Info-HA file

• MWTM-OS-Info-BWG file

• Lists of MIBs, which may 
include:

– (IPRAN only)
RAN MIBs

– (ITP only)
ITP MIBs 

– (mSEF only)
CSG1 MIBs

– (mSEF only)
CSG2 MIBs

– (mSEF only)
GGSN MIBs

– (mSEF only)
BWG MIBs

– (mSEF only)
HA MIBs

– Common MIBs

For details, see Viewing 
System Information for 
the MWTM, page 11-14.

System 
Messages

• Info Messages

• Error Messages

• User Actions

• Message Archives

Shows tabular information 
about different types of system 
messages. 

For details, see Viewing 
System Messages, 
page 11-16.
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Viewing System Information for the MWTM
Depending upon which type(s) of network you are managing, you can view this MWTM system 
information from the Administrative page:

• README—Shows the contents of the /opt/CSCOsgm/install/README.txt file. This file provides 
a brief overview of the system requirements and the tasks that are necessary to install this software 
release.

To access the MWTM README page, choose README from the Administrative page.

• (ITP only) ITP OS README—Shows the contents of the 
/opt/CSCOsgm/install/MWTM-OS-Info-ITP file. This file contains a list of the supported OS 
software images for:

– ITP nodes

– GTT encoding scheme

– MLR address table configuration

System Status • System Status

• System Versions

• Connected Clients

• User Accounts

Shows the output of these 
system commands: 

• mwtm status 

• mwtm version 

• mwtm who 

• mwtm users 

For details, see Viewing 
System Status 
Information, page 11-20.

System Logs • Console Log

• Command Log

• Event Automation 
Log

• Security Log

• Install Log

• Web Access Log

• Web Error Log

• Report Log

Shows the contents of these 
system logs:

• sgmConsoleLog.txt

• sgmCommandLog.txt

• eventAutomationLog.txt

• sgmSecurityLog.txt

• cisco_sgmsvr_install.log

• access_log

• error_log

• sgmReportLog.txt

For details, see Viewing 
System Logs, page 11-22.

Properties • System

• Server

• WebConfig

• Reports

• Trap Forwarding

Shows the contents of these 
system property files:

• System.properties

• Server.properties

• WebConfig.properties

• Reports.properties

• TrapForwarder.properties

For details, see Viewing 
System Properties, 
page 11-25.

Table 11-1 Administrative Page Information (continued)

Pane GUI Elements Description Reference
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– GTT accounting statistics reports

– Route table and GTT table deployment

– MSU rates

– ITP provisioning

To access the MWTM ITP OS README page, choose ITP OS README from the Administrative 
page.

• (IPRAN only) IPRAN OS README—Shows the contents of the 
/opt/CSCOsgm/install/MWTM-OS-Info-IPRAN file. This file contains a list of the supported OS 
software images for:

– MWR nodes 

– ONS nodes

– RAN SVC cards

To access the MWTM IPRAN OS README page, choose IPRAN OS README from the 
Administrative page.

• (mSEF, CSG1 only) CSG1 OS README—Shows the contents of the 
/opt/CSCOsgm/install/MWTM-OS-Info-CSG file. This file contains a list of the supported OS 
software images for CSG1.

To access the MWTM CSG1 OS README page, choose CSG1 OS README from the 
Administrative page.

• (mSEF, CSG2 only) CSG2 OS README—Shows the contents of the 
/opt/CSCOsgm/install/MWTM-OS-Info-CSG2 file. This file contains a list of the supported OS 
software images for CSG2.

To access the MWTM CSG2 OS README page, choose CSG2 OS README from the 
Administrative page.

• (mSEF, GGSN only) GGSN OS README—Shows the contents of the 
/opt/CSCOsgm/install/MWTM-OS-Info-GGSN file. This file contains a list of the supported OS 
software images for GGSN.

To access the MWTM GGSN OS README page, choose GGSN OS README from the 
Administrative page.

• (mSEF, HA only) HA OS README—Shows the contents of the 
/opt/CSCOsgm/install/MWTM-OS-Info-HA file. This file contains a list of the supported OS 
software images for HA.

To access the MWTM HA OS README page, choose HA OS README from the Administrative 
page.

• (mSEF, BWG only) BWG OS README—Shows the contents of the /opt/CSCOsgm/install/
MWTM-OS-Info-BWG file. This file contains a list of the supported OS software images for BWG.

To access the MWTM BWG OS README page, choose BWG OS README from the 
Administrative page.

• MIBs—Shows a list of the MIBs (categorized by product type) on the server to which you are 
connected, and which is currently running the MWTM. 

Each MIB appears in a list as a clickable link. You can open or download the contents of the MIB 
by clicking the MIB name. See Appendix F, “MIB Reference,” for a complete list and high-level 
description of each supported MIB.

To access the MIBs page, choose MIBs from the Administrative page of the MWTM web interface.
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Viewing System Messages
You can view these MWTM system messages from the Administrative page:

Note These messages are related to the MWTM system itself, not to your network.

• Viewing Info Messages, page 11-16

• Viewing Error Messages, page 11-16

• Viewing MWTM User Action Messages, page 11-17

• Viewing All Archived MWTM Messages, page 11-19

Viewing Info Messages

The System Messages: Last number Info Messages page shows informational messages in the MWTM 
system log. These messages can be useful when diagnosing and correcting MWTM operational 
problems.

To access this page, click Info Messages from the Administrative page, or Info from the web page 
menu bar, if visible.

The Last Info Messages table contains:

Viewing Error Messages

The System Messages: Last number Error Messages page shows error messages stored in the MWTM 
system log. These messages can be useful when diagnosing and correcting MWTM operational 
problems.

Column Description

Period
(in heading)

Collection period of the table, such as Since Server Restart.

Timestamp
(in heading)

Date and time the MWTM last updated the information on the page.

Row Unique number identifying each entry in the table. You cannot edit this field.

Time Date and time the message was logged.

To sort the messages by time, click the Time heading.

Source Source for the message, with the format process.host.id, where:

• process is the process that logged the message.

• host is the host name of the process that logged the message.

• id is an MWTM ID that uniquely identifies the process that logged the message; 
or in the event that two or more clients are running on the same node, connected 
to the same MWTM server.

Task Task, or thread, that logged the message.

Message Text of the message.

To sort the messages alphabetically by message text, click the Message heading.
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To access this page, click:

• Error Messages from the Administrative page.

• Error from the web page menu bar, if visible.

The Last Error Messages table contains:

Viewing MWTM User Action Messages

The System Messages: Last number Action Messages page shows user action messages stored in the 
MWTM system log. These messages can be useful when diagnosing and correcting MWTM operational 
problems, and when monitoring audit trails of user actions.

To access this page, use one of these procedures. Click:

• User Actions from the Administrative page.

• Action from the web page menu bar, if visible.

The MWTM shows the System Messages: Last number Action Messages page. The System Messages: 
Last number Action Messages page has these sections:

• Last Action Messages Menu, page 11-18

• Last Action Messages Table, page 11-18

Column Description

Period
(in heading)

Collection period of the table, such as Since Server Restart.

Timestamp
(in heading)

Date and time the MWTM last updated the information on the page.

Row Unique number identifying each entry in the table. You cannot edit this field.

Time Date and time the message was logged.

To sort the messages by time, click the Time heading.

Source Source for the message, with the format process.host.id, where:

• process is the process that logged the message.

• host is the host name of the process that logged the message.

• id is an MWTM ID that uniquely identifies the process that logged the message; 
or in the event that two or more clients are running on the same node, connected 
to the same MWTM server.

Task Task, or thread, that logged the message.

Message Text of the message.

To sort the messages alphabetically by message text, click the Message heading.
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Last Action Messages Menu

By default, the MWTM shows action messages of all classes on the System Messages: Last number 
Action Messages page. However, the MWTM provides menu options that enable you to display only 
messages of a specific class on the page.

The Last Action Messages menu contains:

Last Action Messages Table

The Last Action Messages table contains:

Column Description

Create Opens the System Messages: Last number Action: specified web page:

• Create—Opens the Create Messages web page, showing only Create action 
messages.

• Delete—Opens the Delete Messages web page, showing only Delete action 
messages.

• Discover—Opens the Discover Messages web page, showing only Discover 
action messages.

• Edit—Opens the Edit Messages web page, showing only Edit action messages.

• Ignore—Opens the Ignore Messages web page, showing only Ignore action 
messages.

• OverWrite—Opens the OverWrite Messages web page, showing only 
OverWrite action messages.

• Poll—Opens the Poll Messages web page, showing only Poll action messages.

• Purge—Opens the Purge Messages web page, showing only Purge action 
messages.

• LogInOut—Opens the LogInOut Messages web page, showing only Log in and 
Log out action messages.

• All—Opens a web page that shows all action messages.

• Provision—Opens a web page that shows all provisioning messages.

Delete

Discover

Edit

Ignore

OverWrite

Poll

Purge

LogInOut

All

Provision

Column Description

Period
(in heading)

Collection period of the table, such as Since Server Restart.

Timestamp
(in heading)

Date and time the information on the page was last updated by the MWTM.

Row Unique number identifying each entry in the table. You cannot edit this field.

Time Date and time the message was logged.

To sort the messages by time, click the Time heading.
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Viewing All Archived MWTM Messages

The System Message Archives: All Messages page shows all archived messages in the MWTM system 
logs, including:

• error

• informational

• trace

• debug 

• dump

• messages

• SNMP

To access the System Message Archives: All Messages page, use one of these options. Click:

• Message Archives from the Administrative page.

• Archives from the web page menu bar, if visible.

On the System Message Archives: All Messages page, messages are archived by timestamp. Each 
archived file contains all MWTM system messages for a single session for the server to which you are 
connected, and which is currently running the MWTM server. (If you restart the server, the MWTM 
creates a new file.)

Class Class of the message. Possible classes are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has flagged a link or linkset as Ignored.

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts to log 
in to the MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to the MWTM has 
failed.

• Logout—Logout event. A user has logged out of the MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route file, 
has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing Data 
chosen, and the MWTM has deleted the existing MWTM database.

To sort the messages by class, click the Class heading.

Message Text of the message.

To sort the messages alphabetically by message text, click the Message heading.

Column Description
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To view archived messages, click a timestamp. The System Messages Archive: Last number All 
Messages page appears, which shows all messages that were in the system log at the specified timestamp.

Note You might observe an entry labeled messageLog-old among a list of files that have timestamps in the 
filenames. A daily cron job creates the files with the timestamps. The cron job, which runs at midnight, 
searches through the messageLog.txt and messageLog-old.txt files for all entries from the past day. The 
messageLog-old.txt file exists only if the size of messageLog.txt exceeds the limit set by the mwtm 
logsize command. The MWTM lists the contents of messageLog-old.txt because it could contain 
important data from the day the message log file rolled over. 

The Last All Messages table contains this information (without column headers):

Viewing System Status Information
You can view this MWTM system status information from the Administrative page:

• Viewing System Status, page 11-21

• Viewing System Versions, page 11-21

• Viewing Connected Clients, page 11-21

• Viewing User Accounts, page 11-21

Description Information

Index Message number that the MWTM assigns to the message.

Time Date and time the message was logged.

Type Type of message. Possible types are:

• Action

• Debug

• Dump

• Error

• Info

• SNMP

• Trace

Source Source for the message, with the format process.host.id, where:

• process is the process that logged the message.

• host is the host name of the process that logged the message.

• id is an MWTM ID that uniquely identifies the process that logged the message; or, 
in the event that two or more clients are running on the same node, connected to the 
same MWTM server.

Task Task, or thread, that logged the message.

Message Text of the message.
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Viewing System Status

To access system status information, click System Status from the Administrative page. (The MWTM 
might take a few seconds to display this page.) This page shows the status of all MWTM servers, local 
clients, and processes. 

Viewing System Versions

To access version information, click System Versions from the Administrative page. (The MWTM 
might take a few seconds to display this page.) This page shows version information for all MWTM 
servers, clients, and processes. 

Viewing Connected Clients

To access connected client information, click Connected Clients from the Administrative page. This 
page lists all MWTM clients that are currently connected to the MWTM server. It also lists all Solaris 
and Linux users that are logged in to the MWTM server.

Viewing User Accounts

To access user account information, click User Accounts from the Administrative page. This page shows 
information about all user accounts that have been defined for the MWTM server. If no user accounts 
have been defined, the MWTM shows this message:

User Database is Empty

The user accounts page displays the output of the mwtm users command. For example:

/opt/CSCOsgm/bin/mwtm users

User Name Last Login Level Name & Number Status
-----------------------------------------------------------------
User1 Wed Jan 17 14:03:13 EST 2007 System Admin 5 [Account Enabled]
User2 Unknown  System Admin 5 [Account Enabled]
User3 Wed Jan 17 13:43:30 EST 2007 System Admin 5 [Account Enabled]

User Based Access Protection is Enabled.

Authentication type = local

The the mwtm users command output contains:

Heading Description

User Name The MWTM user for whom a User-Based Access account has been set up.

Last Login Date and time the user last logged in to the MWTM.
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Viewing System Logs
From the Administrative page, you can view: 

• Viewing the Console Log, page 11-22

• Viewing the Command Log, page 11-23

• Viewing the Event Automation Log, page 11-23

• Viewing the Security Log, page 11-23

• Viewing the Install Log, page 11-24

• Viewing the Web Access Logs, page 11-24

• Viewing the Web Error Logs, page 11-24

• Viewing the Report Log, page 11-25

Viewing the Console Log

The Console Log shows the contents of the MWTM system console log file for the server to which you 
are connected, and which is currently running the MWTM. The console log file contains unexpected 
error and warning messages from the MWTM server, such as those that might occur if the MWTM server 
cannot start. It also provides a history of start-up messages for server processes and the time each 
message appeared.

To access the Console Log, click Console Log in the System Logs pane of the Administrative page. You 
can also view the Console Log with the mwtm console command.

Level Name & 
Number

Authentication level and number for the user. Valid levels and numbers are:

• Basic User, 1

• Power User, 2

• Network Operator, 3

• Network Administrator, 4

• System Administrator, 5

Status Current status of the user’s account. Valid status settings are:

• Account Enabled—The account has been enabled and is functioning normally.

• Account Disabled—The account has been disabled for one of these reasons:

– A System Administrator disabled the account. See the “mwtm disablepass” 
section on page B-25 and the “mwtm disableuser” section on page B-26 for 
more information.

– The MWTM disabled the account as a result of too many failed attempts to 
log in using the account. See the “mwtm badlogindisable” section on 
page B-11 for more information.

– The MWTM disabled the account because it was inactive for too many 
days. See the “mwtm inactiveuserdays” section on page B-32 for more 
information.

Heading Description
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Viewing the Command Log

The Command Log shows the contents of the MWTM system command log file for the server to which 
you are connected, and which is currently running the MWTM server. The system command log lists all 
mwtm commands that have been entered for the MWTM server, the time each command was entered, 
and the user who entered the command.

To access the Command Log, click Command Log in the System Logs pane of the Administrative page. 
You can also view the Command Log with the mwtm cmdlog command.

The MWTM Command Log page appears. The Command Log table contains:

Viewing the Event Automation Log

The Event Automation Log shows the contents of the system event automation log file for the server to 
which you are connected, and which is currently running the MWTM server. The system event 
automation log lists all messages that event automation scripts generate.

The default path and filename for the system event automation log file is 
/opt/CSCOsgm/logs/eventAutomationLog.txt. If you installed the MWTM in a directory other than /opt, 
then the system event automation log file is in that directory.

To access the Event Automation Log, click Event Automation Log in the System Logs pane of the 
Administrative page. You can also view the Event Automation Log with the mwtm eventautolog 
command.

Related Topic

Changing the Way the MWTM Processes Events, page 9-35.

Viewing the Security Log

The Security Log shows the contents of the MWTM system security log file for the server to which you 
are connected, and which is currently running the MWTM server. The system security log lists:

• All security events that have occurred for the MWTM server

• The time each event occurred

• The user and command that triggered the event

• The text of any associated message

The default path and filename for the system security log file is /opt/CSCOsgm/logs/sgmSecurityLog.txt. 
If you installed the MWTM in a directory other than /opt, then the system security log file is in that 
directory.

Column Description

Timestamp Date and time the command was logged.

To sort the messages by time, click the Timestamp heading.

User User who entered the command.

To sort the commands by user, click the User heading.

Command Text of the command.

To sort the messages alphabetically by command text, click the Command heading.
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To access the Security Log, click Security Log in the System Logs pane of the Administrative page. You 
can also view the Security Log with the mwtm seclog command.

The Last Security Entries table contains these columns:

Viewing the Install Log 

The Install Log shows the contents of the MWTM system installation log. The installation log contains 
messages and other information recorded during installation, which can be useful when troubleshooting 
problems. The Install Log also records the installer’s selections (for example, whether the installer chose 
to configure the MWTM to receive SNMP traps).

The default path and filename for the install log file is /opt/CSCOsgm/install/cisco_sgmsvr_install.log. 
If you installed the MWTM in a directory other than /opt, then the install log file is in that directory.

To access the Install Log, click Install Log in the System Logs pane of the Administrative page. You can 
also view the Install Log with the mwtm installlog command.

Viewing the Web Access Logs

The Web Access Logs page shows a list of web access log files for the server to which you are connected, 
and which is currently running the MWTM server. The web access log lists all system web access 
messages that have been logged for the MWTM server, providing an audit trail of all access to the 
MWTM server through the MWTM web interface.

The default path and filename for the web access log file is /opt/CSCOsgm/apache/logs/access_log. If 
you installed the MWTM in a directory other than /opt, then the web access log file is in that directory.

To access the Web Access Logs page, click Web Access Logs from with the System Logs pane of the 
Administrative page. You can also view the Web Access Logs page using the mwtm webaccesslog 
command.

Viewing the Web Error Logs

The Web Error Logs page shows a list of web error log files for the server to which you are connected, 
and which is currently running the MWTM server. The web server error log lists all system web error 
messages that have been logged for the MWTM web server. You can use the web error log to 
troubleshoot the source of problems that users may have encountered while navigating the MWTM web 
interface.

Column Description

Timestamp Date and time the security event occurred.

To sort the entries by time, click the Time heading.

User User who triggered the security event.

To sort the entries by user, click the User heading.

Message Text of the security event message.

To sort the entries alphabetically by message text, click the Message heading.

Command Text of the command that triggered the security event.

To sort the entries alphabetically by command text, click the Command heading.
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The default path and filename for the web error log file is /opt/CSCOsgm/apache/logs/error_log. If you 
installed the MWTM in a directory other than /opt, then the web error log file is in that directory.

To access the Web Error Logs page, click Web Error Logs in the System Logs pane of the 
Administrative page. You can also view the Web Error Logs page using the mwtm weberrorlog 
command.

Viewing the Report Log

The Report Log shows the message log for ITP reports for the server to which you are connected, and 
which is currently running the MWTM server. You can view this log to determine the beginning and 
finish times for report generation. The log also records errors that occurred during report generation (for 
example, server connection errors).

The default path and filename for the report log file is /opt/CSCOsgm/logs/sgmReportLog.txt. If you 
installed the MWTM in a directory other than /opt, then the report log file is in that directory.

To access the Report Log, click Report Log in the System Logs pane of the Administrative page. You 
can also view the Report Log with the mwtm replog command.

Viewing Properties
Property files for the MWTM are in the /opt/CSCOsgm/properties directory. You can view these MWTM 
properties from the Administrative page.

• Viewing System Properties, page 11-25

• Viewing Server Properties, page 11-27

• Viewing Web Configuration Properties, page 11-27

• Viewing Reports Properties, page 11-29

• Viewing Trap Forwarding Properties, page 11-30

Viewing System Properties

To access the System Properties file, click System in the Properties pane of the Administrative page. The 
MWTM shows the contents of the /opt/CSCOsgm/properties/System.properties file.

The System Properties file contains MWTM server and client properties that control various MWTM 
configuration parameters. 

You can change some of the system properties using MWTM commands:

To change this system property Use this MWTM command

ATBLDIR mwtm atbldir, page B-90

AUTO_SYNC_CONFIG mwtm autosyncconfig, page B-91

BACKUP_RMIPORT mwtm secondaryserver, page B-56

BACKUP_SERVER

BACKUP_WEBPORT

BACKUPDAYS mwtm backupdays, page B-9

BADLOGIN_TRIES_ALARM mwtm badloginalarm, page B-11
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BADLOGIN_TRIES_DISABLE mwtm badlogindisable, page B-11

CHART_MAX_WINDOW mwtm chartwindow, page B-91

CONSOLE_ARCHIVE_DIR_MAX_SIZE mwtm archivedirsize, page B-8

CONSOLE_LOG_MAX_SIZE mwtm consolelogsize, page B-20

CSV_FIELD_DELIMITER mwtm collectstats, page B-19

CSV_STRING_DELIMITER

CW2K_SERVER mwtm cwsetup, page B-21

CW2K_WEB_PORT

CW2K_SECURE_WEB_PORT

GTTDIR mwtm gttdir, page B-98

JSP_PORT mwtm jspport, page B-36

LOGAGE mwtm msglogage, page B-45

LOGDIR mwtm msglogdir, page B-46

LOGSIZE mwtm logsize, page B-39

LOGTIMEMODE mwtm logtimemode, page B-40

LOG_TROUBLESHOOTING mwtm tshootlog, page B-77

MANAGE_BWG mwtm manage, page B-40

MANAGE_CSG1

MANAGE_CSG2

MANAGE_GGSN

MANAGE_HA

MANAGE_ITP

MANAGE_RAN-O

PERSISTENCEDIR mwtm datadir, page B-22

PROMPT_CREDS mwtm logincreds, page B-38

REQUIRE_ARCHIVE_COMMENTS mwtm deploycomments, page B-95

ROUTEDIR mwtm routedir, page B-114

SBACKUPDIR mwtm backupdir, page B-10

SERVER_NAME mwtm servername, page B-57

SNMPCONFFILE mwtm snmpconf, page B-60

SSL_ENABLE mwtm ssl, page B-70

TFTP_ATBLPATH mwtm atbldir, page B-90

TFTP_GTTPATH mwtm gttdir, page B-98

TFTP_ROUTEPATH mwtm routedir, page B-114

TRAP_LIST_ENABLE mwtm trapsetup, page B-76

TRAP_PORT

USE_TERMINAL_PROXY mwtm termproxy, page B-75

To change this system property Use this MWTM command
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For these system properties, you can view related documentation:

Viewing Server Properties

To access the Server Properties file, click Server in the Properties pane of the Administrative page. The 
MWTM shows the contents of the /opt/CSCOsgm/properties/Server.properties file.

The Server Properties file contains various properties that control the MWTM server.

You can use MWTM commands to change these server properties:

To change poller parameters in the Server Properties file, see the “Changing MWTM Server Poller 
Settings” section on page 3-2.

Viewing Web Configuration Properties

To access the Web Configuration Properties file, click WebConfig in the Properties pane of the 
Administrative page. The MWTM shows the contents of the /opt/CSCOsgm/properties/
WebConfig.properties file. 

The Web Configuration Properties file contains properties that control the configuration of the MWTM 
web interface. For example:

MAX_ASCII_ROWS      = 6000
MAX_HTML_ROWS       = 100

# The selectable page sizes start at MIN_SELECTABLE_PAGE_SIZE and doubles until
# the MAX_SELECTABLE_PAGE_SIZE value is reached
# (e.g. 25, 50, 100, 200, 400, 800)
MIN_SELECTABLE_PAGE_SIZE = 25
MAX_SELECTABLE_PAGE_SIZE = 800
LOG_UPDATE_INTERVAL = 300

VCS_REPOSITORY_DIR mwtm archivedir, page B-88

WEB_PORT mwtm webport, page B-83

WEB_BROWSER mwtm browserpath, page B-12

To change this system property Use this MWTM command

System Property Related Documentation

CLIENT_PORT Configuring Port Numbers and Parameters, page H-7

DATASERVER_PORT

LOGINSERVER_PORT

RMIREGISTRY_PORT

MAX_CHART_SERIES Viewing Backhaul Performance Data, page 8-111

To change this server property Use this MWTM command

DEMAND_POLLER_TIMELIMIT mwtm pollertimeout, page B-49

SNMP_MAX_ROWS mwtm snmpwalk, page B-66

UNKNOWN_AGING_TIMEOUT mwtm unknownage, page B-78
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WEB_UTIL            = percent
WEB_NAMES           = display
MAX_EV_HIST         = 15000

You can use the MWTM to change the web configuration properties:

Web Configuration Property Changing Default Setting

LOG_UPDATE_INTERVAL To control how often, in seconds, the MWTM updates certain web 
output, use the mwtm weblogupdate command. The valid range is 1 
second to an unlimited number of seconds. The default value is 300 
seconds (5 minutes).

MAX_ASCII_ROWS To set the maximum number of rows for MWTM ASCII web output, 
such as displays of detailed debugging information, use the mwtm 
maxasciirows command. The valid range is 1 row to an unlimited 
number of rows. The default value is 6,000 rows.

MAX_EV_HIST To set the maximum number of rows for MWTM to search in the event 
history logs, use the mwtm maxevhist command. The event history 
logs are the current and archived MWTM network status logs for status 
change and SNMP trap messages. The MWTM sends the results of the 
search to the web browser, where the results are further limited by the 
setting of the mwtm maxhtmlrows command. The valid range is 1 row 
to an unlimited number of rows. The default value is 15,000 rows.

MAX_HTML_ROWS To set the maximum number of rows for MWTM HTML web output, 
such as displays of statistics reports, status change messages, or SNMP 
trap messages, use the mwtm maxhtmlrows command. This lets you 
select a page size (if you have not explicitly chosen a page size). Once 
you select a page size from any page, the MWTM remembers your 
preference until you delete your browser cookies. The default value is 
100 rows.

MIN_SELECTABLE_PAGE
_SIZE

This setting determines the minimum page size for the user to select 
from the Page Size drop-down menu. The page size values start with the 
MIN_SELECTABLE_PAGE_SIZE and double until they reach the 
MAX_SELECTABLE_PAGE_SIZE.

MAX_SELECTABLE_
PAGE_SIZE

This setting determines the maximum page size for the user to select 
from the Page Size drop-down menu. The page size values start with the 
MIN_SELECTABLE_PAGE_SIZE and double until they reach the 
MAX_SELECTABLE_PAGE_SIZE.
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Each of the web configuration commands requires you to be logged in as the root user, as described in 
the “Becoming the Root User (Server Only)” section on page 4-2, or as a superuser, as described in the 
“Specifying a Super User (Server Only)” section on page 2-20.

Related Topic

Link Reports, page 12-17.

Viewing Reports Properties

To access the Reports Properties file, click Reports in the Properties pane of the Administrative page. 
The MWTM shows the contents of the /opt/CSCOsgm/properties/Reports.properties file.

The Reports Properties file contains properties that control various aspects of the reports that are 
available in the MWTM web interface. 

You can use MWTM commands to change these reports properties:

WEB_NAMES To specify whether the MWTM should show real DNS names or display 
names in web pages, enter the mwtm webnames command. To show:

• The real DNS names of nodes, as discovered by the MWTM, enter 
mwtm webnames real.

• Display names, enter mwtm webnames display. Display names 
are new names that you specify for nodes. This is the default 
setting. For more information about display names, see the 
“Editing Properties” section on page 6-33.

WEB_UTIL To specify whether the MWTM should display send and receive 
utilization as percentages or in Erlangs in web pages, enter the mwtm 
who command. To show:

• Utilization as a percentage, enter mwtm webutil percent. This is 
the default setting.

• Display utilization in Erlangs (E), enter mwtm webutil erlangs.

See Viewing RAN-O Performance Data, page 8-107 and Viewing 
RAN-O Error Data, page 8-115 for more information on send and 
receive utilization for shorthauls and backhauls. 

See Chapter 12, “Managing Reports” for more information on send and 
receive utilization for linksets and links. 

Web Configuration Property Changing Default Setting

To change this server property Use this MWTM command

ACC_REPORTS mwtm accstats, page B-87

GTT_REPORTS mwtm gttstats, page B-100

LINK_REPORTS mwtm linkstats, page B-101

MLR_REPORTS mwtm mlrstats, page B-105

MSU_REPORTS mwtm statreps msu, page B-124

Q752_REPORTS mwtm q752stats, page B-110

RPT_15MIN_AGE mwtm rep15minage, page B-130
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Viewing Trap Forwarding Properties

To access the Trap Forwarding Properties file, click TrapForwarding in the Properties pane of the 
Administrative page. The MWTM shows the contents of the 
/opt/CSCOsgm/properties/TrapForwarder.properties file.

The Trap Forwarder Properties file contains a list of the destination addresses for the trap forwarder. 
Enter each destination address on its own line and use this format:

SERVERxx=destination_IP_address[:port_number]

The port_number parameter is optional.

Displaying Alarms and Events
To display alarms in the web interface, click Active Alarms in the navigation tree, or select an object in 
the navigation tree and click the Alarms tab.

To display events in the web interface, click Event History in the navigation tree, or select an object in 
the navigation tree and click the Recent Events tab.

Viewing alarms and events in the web interface is essentially the same as viewing them in the MWTM 
client. Only minor differences exist:

• A paging feature for paging through large tables.

• A refresh interval that you can change.

• An Archived link for viewing archived alarms.

• Alarm selection by check box and a Clear Selection link.

• Severity drop-down list and a Change Severity button.

For detailed descriptions of these tools, see the “Using the Toolbar” section on page 11-5

For descriptions of the columns, see the “Right-click Menus” section on page 9-16.

RPT_CUSTOM_AGE mwtm repcustage, page B-112

RPT_DAILY_AGE mwtm repdailyage, page B-52

RPT_HOURLY_AGE mwtm rephourlyage, page B-53

RPT_IPLINKS mwtm statreps iplinks, page B-122

RPT_MONTHLY_AGE mwtm restart, page B-53

RPT_NULLCAPS mwtm statreps nullcaps, page B-125

RPT_SERVRATIO mwtm statreps servratio, page B-126

RPT_TIMEMODE mwtm statreps timemode, page B-127

STATS_REPORTS mwtm statreps servratio, page B-126

XUA_REPORTS mwtm xuastats, page B-129

To change this server property Use this MWTM command
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Displaying Summary Lists
Displaying Summary Lists in the web interface is essentially the same as displaying them in the MWTM 
client. Only minor differences exist. Clicking on an object under the Summary Lists in the web interface 
causes the content area to show information about the object. 

For details on:

• Navigating table columns, see Navigating Table Columns, page 5-24. 

• The toolbar, see Using the Toolbar, page 11-5.

For complete information about Summary Lists, see the “Displaying Object Windows” section on 
page 6-2.

Displaying Software Versions
The Software Versions table lists the software versions for each node the MWTM manages.

To access the Software Versions page:

• From the Web interface navigation tree, select Summary Lists > Software Versions.

• From the MWTM main window, select View > Web > Software Versions.

For details on:

• Navigating the columns of the Software Versions table, see Navigating Table Columns, page 5-24. 

• The toolbar, see Using the Toolbar, page 11-5.

The Software Versions table contains:

Tools
To access launch and search tools, click Tools in the navigation tree of the MWTM web interface. This 
action opens a Launch pane and a Search pane in the content area:

• Launch Tools, page 11-32

• Search Tools, page 11-32

Column Description

Name Name of the node.

Node Type Type of node.

Software 
Version

Software version used by the node.

Software 
Description

Full software version information. 
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Launch Tools
If you have integrated with a CiscoWorks server, one or more of the following applications appears in 
the Launch pane as active links:

• CiscoView

• CiscoWorks LMS Portal

• CSG Service Manager

• Device Center

• GGSN Service Manager

The name of the server appears in parentheses following the application names. To launch an application, 
click the application name. See Integrating the MWTM with Other Products, page 5-39.

Note The MWTM attempts to launch the URL of the service manager that resides on the LMS server. If the 
service manager is not installed on the LMS server, you will receive an HTTP 404 error. To prevent this 
error, ensure that the service managers are installed on the LMS server, or remove the CSG or GGSN 
network setting with the mwtm manage, page B-40, command.

Search Tools

Note You must have the Cisco Home Agent (HA) network enabled to use this tool (for details on enabling HA, 
see mwtm manage, page B-40).

The Search pane provides a tool that you use to search for a specific subscriber across one or more 
designated Cisco Home Agent (HA) routers. This tool is useful for troubleshooting problems that HA 
subscribers may report. To search for an HA subscriber:

Step 1 Click Search for Home Agent Subscriber in the Search pane.

Step 2 Click the Identifier Type radio button:

• Network Access Identifier—Use this option if you know the subscriber’s network access identifier 
(NAI); for example, jdoe@xyz.com.

• IP Address—Use this option if you know the subscriber’s IP address

Step 3 Depending on your selection in Step 2, enter the subscriber’s NAI or IP address in the Mobile Node 
Identifier field.

Step 4 In the Select Home Agents to Search pane, check the check boxes of the Home Agents that you want to 
search. (The default setting is all Home Agents.)

Step 5 To conduct the search, click the Search button. 

The Search Results popup window appears.

Step 6 If the search successfully locates the subscriber, and you want to troubleshoot the problem, click the 
Troubleshoot Subscriber button in the Search Results popup. 

The MWTM automatically navigates to the Troubleshooting tab of the HA device.
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Step 7 For more information about troubleshooting devices by using the Troubleshooting tab, see Viewing 
Troubleshooting, page 8-43.

Displaying Reports

Note If MWTM User-Based Access is enabled, only users with authentication level 4 (Network 
Administrator) and higher can see the Reports menu.

You can display reports primarily for ITP objects in the MWTM Web interface. An overview and a 
complete list and description of these reports is available in Chapter 12, “Managing Reports.”

Event reports are also available for both RAN-O and ITP networks, also available in the Reports menu. 
For details, see the “Viewing Archived Event Files on the Web” section on page 9-30 and the “Viewing 
the Event Metrics Report on the Web” section on page 9-30.

You can also display network-wide RAN-O reports in the Reports menu. For details, see Viewing RAN 
Reports, page 12-75.

Displaying Objects in a View
Displaying objects in a view in the MWTM web interface is essentially the same as viewing them in the 
MWTM client. Only minor differences exist. The MWTM web interface:

• Shows a subset of the columns that the client interface shows. 

• Has a paging feature. See the “Using the Toolbar” section on page 11-5.

• Has a refresh interval that you can change.

• Displays a Statistics tab when you select a CSG2 or BWG Gateway node in the navigation tree. See 
Displaying CSG2 Real-Time Statistics, page 11-44, or Displaying BWG Real-Time Statistics, 
page 11-49. The Statistics tab appears only on the web interface for these node types.

• When viewing CPU Utilization in the Performance tab, the MWTM web interface displays the data 
in tabular format instead of graph format. See CPU Utilization, page 8-59.

• When viewing performance and error information for interfaces (in the Interface Performance and 
Interface Errors tabs), the MWTM web interface displays the data in tabular format only. The 
MWTM client interface displays the data in tabular and graph format. See Viewing Data for 
Interfaces, page 8-63.

For details on each object type, see the “Displaying Object Windows” section on page 6-2.

Displaying RAN-O Historical Statistics
The MWTM web interface provides access to RAN-O historical statistics in the MWTM database. You 
can use these statistics for capacity planning and trend analysis. For example, you can generate graphs, 
tables, or CSV files:

• For a specified time range to display historical statistics for customer busy-hours. 
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• To show the maximum send and receive traffic over a specified time period. 

• To show data on a 15-minute, daily, or hourly basis. 

Using this information, you can perform detailed analysis of historical traffic utilization on the backhaul 
and shorthaul links to plan future facility upgrades.

Note The MWTM client provides real-time (not historical) graphs depicting performance and error 
information occurring in real time. You use real-time statistics for troubleshooting active problem areas 
in your network. See Viewing RAN-O Performance Data, page 8-107 and Viewing RAN-O Error Data, 
page 8-115.

This section provides information about:

• Displaying Performance Statistics, page 11-34

• Displaying Error Statistics, page 11-39

• Generating RAN Data Export Files, page 11-43

Displaying Performance Statistics
You can view performance data for a shorthaul or backhaul interface in the MWTM:

• Web interface by selecting a shorthaul or backhaul interface in the navigation tree and clicking the 
Shorthaul Performance or Performance tab in the right pane.

• Client interface by right-clicking a shorthaul or backhaul interface in the navigation tree and 
clicking Performance History.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > Web > Administrative; then click IPRAN OS README.

The Performance tab shows one or more graphs depending on the type of report chosen. These graphs 
depict send and receive rates of optimized IP traffic over a specified time range. The graphs display the 
traffic in bits per second. Each data series shows maximum, minimum, and average rates of optimized 
traffic.

The Performance tab for a backhaul interface shows total rates for GSM and UMTS traffic, including 
total error rates.

This section provides information about:

• Displaying Shorthaul Performance Statistics, page 11-35

• Displaying Backhaul Performance Statistics, page 11-36
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Displaying Shorthaul Performance Statistics

The Shorthaul Performance tab for a shorthaul interface shows the maximum, minimum, and average 
rates for send and receive traffic. 

Figure 11-2 Performance Tab for Shorthaul Interface

The Shorthaul Performance tab for a shorthaul interface contains: 

GUI Element Description

Toolbar Provides functions to select a report type, duration, output type. See Using the 
Toolbar, page 11-5.

Type A comprehensive summary of minimum, average, and maximum capacity statistics 
for send and receive traffic on a RAN shorthaul. You can choose from 15-minute, 
hourly, or daily capacity summary reports, or choose a custom range.
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Displaying Backhaul Performance Statistics

The Performance tab for a backhaul interface shows minimum, average, and maximum traffic rates for 
send and receive traffic. You can also determine the percentage of backhaul utilization that various traffic 
types occupy. Error rates appear, too. 

Table If the Output Type is Graph, the table contains:

• Data Type—Type of data, send or receive

• Average—Average of the data across the chosen time range

• Minimum—Minimum value across the chosen time range 

• Minimum Timestamp EDT—Time the minimum value occurred 

• Maximum—Maximum value across the chosen time range 

• Maximum Timestamp EDT—Time the maximum value occurred

Note If the Output Type is Table or CSV, the same data is presented but the 
column headings are labeled by data type (for example, Send Average and 
Receive Average).

Expand to Full 
Screen

If Output Type is Graph, this text link that displays the graph in a new, full-screen 
window for easier viewing.

Bits/Sec If Output Type is Graph, Y-axis label that shows traffic rate in bits per second. The 
Y axis automatically scales to the interface speed. 

Note If no data exists between any two data points, the graph displays a 
color-coded vertical bar to show the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the 
server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic rates.

GUI Element Description
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Figure 11-3 Example of Performance Tab for Backhaul Interface

The Performance tab for a backhaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph 
Series Editor. See the “Using the Toolbar” section on page 11-5.

Type Report Type. If you choose a Capacity Summary report, the report shows a 
comprehensive summary of minimum, average, and maximum capacity statistics 
for total traffic (GSM-Abis and UMTS-Iub), total GSM-Abis traffic, and total 
UMTS-Iub traffic. You can choose from 15-minute, hourly, or daily capacity 
summary reports. Error rates appear, too.

If Output Type is Graph, statistics appear in three graphs:

• Top—Capacity statistics for send traffic rates, including percentage of 
backhaul utilization (right side of graph).

• Middle—Capacity statistics for receive traffic rates, including percentage of 
backhaul utilization (right side of graph).

• Bottom—Error counts for send and receive traffic.
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Type (continued) If you choose a Minimum, Average, or Maximum Capacity report, the tables and 
graphs show capacity statistics for the backhaul interface. You can choose from 
15-minute, hourly, or daily capacity reports.

If Output Type is Graph, send and receive rate statistics appear in separate panes. 
Each pane shows two fully expandable graphs:

• Top—Shows total (GSM-Abis and UMTS-Iub), total GSM-Abis, and total 
UMTS-Iub traffic rates, including percentage of backhaul utilization (right 
side of graph).

• Bottom—Shows traffic rates for each shorthaul interface that belongs to the 
backhaul.

Table Note Different tables appear depending on the report Type and Output Type 
selections.

If the Output Type is Graph, a table appears with these columns:

• Data Type—Type of data, send or received

• Average—Average of the data across the chosen time range

• Minimum—Minimum value across the chosen time range 

• Minimum Timestamp EDT—Time the minimum value occurred 

• Maximum—Maximum value across the chosen time range 

• Maximum Timestamp EDT—Time the maximum value occurred

Note If the Output Type is Table or CSV, similar data is presented but the column 
headings may vary. Also, if the value is N/A, that means no data is 
available.

Another table has these columns:

• Data Type—Category of error for which statistics are gathered. Types include 
optimization, missed packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for 
each error type over the duration of the data range that you chose.

Note You can sort the contents of the columns in ascending or descending order 
by clicking the column heading.

Expand to Full 
Screen

If Output Type is Graph, text link that shows a graph in a new, full-screen window 
for easier viewing.

Bits/Sec If Output Type is Graph, primary Y-axis label (left side of graph) that shows traffic 
rate in bits per second. The Y axis automatically scales to the User Bandwidth. See 
the“Editing Properties for a RAN-O Backhaul” section on page 6-36. 

Note If no data exists between any two data points, the graph displays a 
color-coded vertical bar to show the period for which no data is available.

GUI Elements Description
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Displaying Error Statistics
You can view error data for a shorthaul or backhaul interface in the MWTM: 

• Web interface by selecting an interface in the navigation tree and clicking the Shorthaul Errors or 
Errors tab in the content area.

• Client by right-clicking an interface in the navigation tree and clicking Error History.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > Web > Administrative; then click IPRAN OS README.

You view error data for a shorthaul or backhaul interface by selecting the interface in the navigation tree 
and clicking the Errors tab in the content area. The Errors tab shows total error counts and average error 
rates in table and graph format. 

This section provides information about:

• Displaying Shorthaul Error Statistics, page 11-40

• Displaying Backhaul Error Statistics, page 11-42

% Utilization If Output Type is Graph, secondary Y-axis label (right side of graph) that shows the 
backhaul utilization as a percentage of the User Bandwidth. The graph background 
has three horizontal bars that are color-coded to indicate these thresholds:

• Overloaded—Top portion of graph.

• Warning—Middle portion of graph.

• Acceptable—Bottom portion of graph.

For definitions of these thresholds, see the “Threshold Information (RAN-O Only)” 
section on page 8-43.

To change the threshold settings, see the “Editing Properties for a RAN-O 
Backhaul” section on page 6-36.

Note If the % Utilization exceeds 100%, see Why does my backhaul utilization 
graph show greater than 100% for transmit traffic?, page C-22.

Time X-axis label that shows a user-specified, historical time scale and the server time 
zone.

Legend Color-coded legend that shows labels for traffic and error rates.

GUI Elements Description
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Displaying Shorthaul Error Statistics

The Shorthaul Errors tab for a shorthaul interface shows a single table and a graph that shows the error 
rates and counts for different types of GSM-Abis and UMTS-Iub errors. 

Figure 11-4 Example of Errors Tab for Shorthaul Interface
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The Shorthaul Errors tab for a shorthaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select report type, duration, and output type. See the 
“Using the Toolbar” section on page 11-5.

Type Report Type. If you choose an Error Summary report, the table and graph display 
a comprehensive summary of total error counts and average error rates for 
protocol, missed-packet, and miscellaneous errors for the chosen shorthaul. You 
can choose from 15-minute, hourly, or daily error summary reports. Statistics 
appear in table and graph format. 

Type (continued) If you choose an error report that is not a summary report, the table and graph 
displays protocol, missed packet, or miscellaneous errors for the shorthaul 
interface. You can choose from 15-minute, hourly, or daily error reports. 
Statistics appear in table and graph format.

For definitions of these error types, see:

• Protocol Failures, page 8-117

• Miscellaneous, page 8-118

• Missed Packets, page 8-119

Table Note Different tables and column headings appear depending on the report 
Type and Output Type selections.

If Output Type is Graph, a table appears with these columns:

• Data Type—Category of error for which statistics are gathered. Types 
include protocol, missed packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for 
each error type over the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.

Depending on the report Type selection, if the Output Type is Table or CSV, a 
table appears with multiple columns showing various error types and their 
counts. For definitions of these error types, see the:

• Protocol Failures, page 8-117

• Miscellaneous, page 8-118

• Missed Packets, page 8-119

Note You can sort the contents of the columns in ascending or descending 
order by clicking the column heading.

Expand to Full 
Screen

If Output Type is Graph, this text link displays a graph in a new, full-screen 
window for easier viewing.

Error Counts If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate 
in bits per second. 

Note If no data exists between any two data points, the graph displays a 
color-coded vertical bar to show the period for which no data is available.
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Displaying Backhaul Error Statistics

The Errors tab for a RAN backhaul interface shows a single table and a graph that shows the error rates 
and counts for different interfaces belonging to the backhaul. 

Figure 11-5 Example of Errors Tab for Backhaul Interface

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time 
scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic and 
error rates.

GUI Elements Description
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The Errors tab for a backhaul interface contains: 

Generating RAN Data Export Files
You can easily generate historical reports for RAN backhauls and shorthauls in the web interface. You 
can then export this data to a report with comma-separated values (CSV file). You can save this file to 
disk or open it with an application that you choose (for example, Microsoft Excel). 

To export RAN data:

Step 1 Select a RAN backhaul or shorthaul in the navigation tree of the web interface.

Step 2 Click the Performance or Errors tab in the right pane.

Step 3 Generate a report.

Step 4 Click the Export the report as a CSV file icon . 

GUI Elements Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph 
Series Editor. See the “Using the Toolbar” section on page 11-5.

Table Note Different tables and column headings appear depending on the report 
Type and Output Type selections.

If Output Type is Graph, a table appears with these columns:

• Data Type—Category of error for which statistics are gathered. Types 
include optimization, missed packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for 
each error type over the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.

If Output Type is Table, a table appears with columns for total error counts for 
various error types (for example, total GSM-Abis errors).

Note You can sort the contents of the columns in ascending or descending 
order by clicking the column heading.

Expand to Full 
Screen

If Output Type is Graph, text link that shows a graph in a new, full-screen window 
for easier viewing.

Error Counts If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate 
in bits per second. 

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time 
scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic and 
error rates (for example, Total Errors UMTS-Iub).
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Displaying CSG2 Real-Time Statistics
The MWTM enables you to display real-time statistics for CSG2 nodes in the MWTM web interface. To 
display real-time statistics, select the node in the navigation tree and click the Statistics tab. Four 
categories of statistics appear:

• Global Statistics, page 11-44

• Load Statistics, page 11-45

• BMA Statistics, page 11-47

• Quota Server Statistics, page 11-48

• User Database Statistics, page 11-49

Note For toolbar details, see Using the Toolbar, page 11-5.

Global Statistics
The Global Statistics pane contains: 

Field Description

User Current The total number of users with one or more active sessions on the system.

Session Current The total number of sessions on the system. A session corresponds to a 
transmission control protocol (TCP) or user datagram protocol (UDP) 
flow.

User High Water The highest number of active users reported by the User Current field since 
its last reset.

Session High Water The highest number of active sessions reported by the Session Current field 
since its last reset.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or 
later. 

GTP BMA Rejected Number of messages received from all the BMAs with reject cause code.

GTP BMA Dropped Total Number of messages dropped destined for any of the BMAs

GTP BMA Retransmit The number of messages retransmitted to all BMAs.

GTP QuotaMgr Dropped Number of messages received from all the Quota Managers with reject 
cause code. 

GTP QuotaMgr Dropped Total Number of messages dropped destined for any of the Quota 
Managers.

GTP QuotaMgr 
Retransmit

 The number of messages retransmitted to all the Quota Managers.
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Load Statistics
Load statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later.

The Load Statistics pane contains: 

Description

Statistics Type Column Defines the type of statistics for each row: 

• Radius Start Requests

• Session Create Requests

• BMA Messages

• Messages to Quota Server

• User Database Requests

Radius Start 
Requests

Allowed Number of outgoing Radius Start requests allowed. 

Allowed Rate Number of outgoing Radius Start requests allowed per 
second.

Allowed Rate 
High Water

The highest number of outgoing Radius Start requests 
allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for Radius Start requests in the IPC 
queue. 

Denied Number of outgoing Radius Start requests denied.

Denial Rate Number of outgoing Radius Start requests denied per 
second.

Denial Rate
High Water

The highest number of outgoing Radius Start requests 
denied per second. 

Session Create 
Requests

Allowed Number of outgoing Session Create Requests allowed. 

Allowed Rate Number of outgoing Session Create Requests allowed per 
per second.

Allowed Rate 
High Water

The highest number of outgoing Session Create Requests 
allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for Session Create Requests in the 
IPC queue. 

Denied Number of outgoing Session Create Requests denied.

Denial Rate Number of outgoing Session Create Requests denied per 
second.

Denial Rate
High Water

The highest number of outgoing Session Create Requests 
denied per second. 
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BMA Messages Allowed Number of outgoing BMA messages allowed. 

Allowed Rate Number of outgoing BMA messages allowed per second.

Allowed Rate 
High Water

The highest number of outgoing BMA messages allowed 
per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for BMA messages in the IPC 
queue. 

Denied Number of outgoing BMA messages denied.

Denial Rate Number of outgoing BMA messages denied per second.

Denial Rate
High Water

The highest number of outgoing BMA messages denied per 
second. 

Messages to Quota 
Server

Allowed Number of outgoing messages to Quota Manager allowed. 

Allowed Rate Number of outgoing messages to Quota Manager allowed 
per second.

Allowed Rate 
High Water

The highest number of outgoing messages to Quota 
Manager allowed per second. 

IPC Queue Depth 
Tolerance

Maximum queue depth for messages to Quota Manager in 
the IPC queue. 

Denied Number of outgoing messages to Quota Manager denied.

Denial Rate Number of outgoing messages to Quota Manager denied 
per second.

Denial Rate
High Water

The highest number of outgoing messages to Quota 
Manager denied per second. 

User Database 
Requests

Allowed Number of outgoing User Database requests allowed. 

Allowed Rate Number of outgoing User Database requests allowed per 
per second.

Allowed Rate 
High Water

The highest number of outgoing User Database requests 
allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for User Database requests in the 
IPC queue. 

Denied Number of outgoing User Database requests denied.

Denial Rate Number of outgoing User Database requests denied per 
second.

Denial Rate
High Water

The highest number of outgoing User Database requests 
denied per second. 

Description
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BMA Statistics
The Billing Mediation Agent (BMA) Statistics pane contains: 

Column Description

Server Name of the BMA server.

Port The UDP port of the BMA.

VRF Name Name of the virtual routing and forwarding (VRF) over which communication 
with BMA occurs. If no VRF is specified, the global routing table is used.

State The state of the BMA. Possible states include:

• Standby—The server is prepared to become active.

• Failed—The server has failed to respond to requests.

• Active—The server has been activated to receive requests.

• Echowait—An echo request to this billing mediation agent is waiting for a 
response.

• Nawait—A node-alive request to this billing mediation agent is waiting for 
a response.

• Suspended—The server has received a stop request from the operator.

Lost Records Total number of lost records since system initialization or the last time the 
counter wrapped.

Total Sent Total number of records sent to the billing mediation agent.

Failed Acks Number of acknowledgments received from the billing mediation agent for 
which there are no outstanding requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon 
indicates the trend (up or down) since the last poll.

Outstanding High 
Water

The highest number of messages waiting for acknowledgements as reported by 
the Outstanding field since its last reset. 

Bad Records The number of bad records received. These are records in which an error was 
detected while attempting to decode the contents.

Retransmits The number of messages retransmitted to the billing mediation agent.

Sent Rate Rate at which records are sent to the billing mediation agent.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or 
later. 

Rate Interval The duration of time interval in Packet Rate and Ack Rate.

Packet Rate Number of packets sent to the BMA per second calculated over the interval 
indicated by Rate Interval.

Ack Rate Number of acknowledgments received from the BMA per second calculated over 
the interval indicated by Rate Interval.
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Quota Server Statistics
The Quota Server Statistics pane contains: 

Column Description

Server Name of the quota server.

Port The UDP port of the quota server.

VRF Name Name of the VRF over which communication with the quota server occurs. If no 
VRF is specified, the global routing table is used.

State The state of the quota manager. Possible states include:

• Standby—The quota manager is prepared to become active.

• Failed—The quota manager has failed to respond to requests.

• Active—The quota manager has been activated to receive requests.

• Echowait—An echo request to this quota manager is waiting for a response.

• Nawait—A node-alive request to this quota manager is waiting for a 
response.

• Suspended—The quota manager has received a stop request from the 
operator.

Lost Records Total number of lost records since system initialization or the last time the 
counter wrapped.

Total Sent Total number of records sent to the quota server.

Failed Acks Number of acknowledgments received from the quota server for which there are 
no outstanding requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon 
indicates the trend (up or down) since the last poll.

Outstanding High 
Water

The highest number of messages waiting for acknowledgements as reported by 
the Outstanding field since its last reset. 

Bad Records The number of bad records received. These are records in which an error was 
detected while attempting to decode the contents.

Retransmits The number of messages retransmitted to the quota manager.

Sent Rate Rate at which records are sent to the quota server.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or 
later. 

Rate Interval The duration of time interval in Packet Rate and Ack Rate. 

Packet Rate Number of packets sent to the Quota Manager per second calculated over the 
interval indicated by Rate Interval.

Ack Rate Number of acknowledgments received from the Quota Manager per second 
calculated over the interval indicated by Rate Interval. 
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User Database Statistics
The user database is a service that translates a client IP address into a user identifier. The User Database 
Statistics pane contains: 

Displaying BWG Real-Time Statistics
The MWTM enables you to display real-time statistics for Broadband Wireless Gateway (BWG) nodes 
in the MWTM web interface. To display BWG real-time statistics, select a BWG node in the navigation 
tree and click the Statistics tab. These four subtabs appear:

• Global Statistics, page 11-49

• Paths Statistics, page 11-58

• User Groups Statistics, page 11-59

Global Statistics
The Global statistics subtab shows global statistics for BWG nodes and contains:

• Status, page 11-50

• Creation and Deletion Statistics, page 11-51

• Miscellaneous Statistics, page 11-52

• Signaling Packet Statistics, page 11-53

Column Description

Server Name of the user database server.

Port The listening UDP port of the server.

VRF Name Name of the VRF over which communication with user data server occurs. If no 
VRF is specified, the global routing table is used.

State State of the user database. Possible values include:

Reset—State before the database is determined to be active.

Active—The database is available and processing requests.

Failed—The database has failed and is not processing requests.

Requests Number of user database requests.

User Identifiers 
Returned

Number of user identifiers returned.

Requests Resent Number of user database requests resent.

Request Timeouts Number of user database requests that have timed out.

Request Errors Number of errors returned on user database requests.

Requests Rate Rate of user database requests.

User Identifiers 
Returned Rate

Rate at which user identifiers are returned.
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• DHCP Packet Statistics, page 11-53

• Handoff Statistics, page 11-54

• Data Packet Statistics, page 11-55

• Dropped Packet Statistics, page 11-56

• Profile Statistics, page 11-57

• Rejected Statistics, page 11-58

Note For toolbar details, see Using the Toolbar, page 11-5.

Status

The Status pane shows:

Field Description

Version Software version of the BWG.

Description Description of the physical instance of the BWG.

Operational State Current operational state of the BWG.

Session 
Redundancy Status

Indicates whether session redundancy is enabled or disabled.
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Creation and Deletion Statistics

The Creation and Deletion Statistics pane shows:

Field Description

Base Stations • Maximum—Maximum number of base stations that can be concurrently 
supported by this BWG.

• Current—Current number of signaling paths to all base stations. One 
signaling path is created between the BWG and each base station, so the 
current number of signaling paths is equal to the number of base stations 
currently connected to the BWG. 

• Created Count—Total number of signaling paths created on this BWG which 
include active and past signaling paths.

• Created Rate—Rate at which signaling paths are created.

• Deleted Count—Total number of signaling paths deleted on this BWG.

• Deleted Rate—Rate at which signaling paths are deleted.

Data Paths • Maximum—N/A

• Current—Current number of data paths to all base stations.

• Created Count—Total number of data paths created on this BWG which 
include active and past data paths.

• Created Rate—Rate at which data paths are created.

• Deleted Count—Total number of data paths deleted on this BWG.

• Deleted Rate—Rate at which data paths are deleted.

Subscribers • Maximum—Maximum number of subscribers that can be concurrently 
supported by this BWG.

• Current—Number of subscribers currently connected to this BWG.

• Created Count—Total number of subscribers created on this BWG which 
includes active and past subscribers

• Created Rate—Rate at which subscribers are created.

• Deleted Count—Total number of subscribers deleted on this BWG.

• Deleted Rate—Rate at which subscribers are deleted.

Sessions • Maximum—N/A

• Current—Number of sessions currently active on this BWG.

• Created Count—Total number of sessions created on this BWG which 
include active and past sessions.

• Created Rate—Rate at which sessions are created.

• Deleted Count—Total number of sessions deleted on this BWG.

• Deleted Rate—Rate at which sessions are deleted.
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Miscellaneous Statistics

The Miscellaneous Statistics pane shows:

Flows • Maximum—N/A

• Current—Current number of flows for all sessions active on this BWG.

• Created Count—Total number of flows created on this BWG which include 
active and past flows.

• Created Rate—Rate at which flows are created.

• Deleted Count—Total number of flows deleted on this BWG.

• Deleted Rate—Rate at which flows are deleted.

Hosts • Maximum—N/A

• Current—Current number of hosts connected to this BWG.

• Created Count—Total number of hosts created on this BWG which include 
active and past hosts.

• Created Rate—Rate at which hosts are created.

• Deleted Count—Total number of hosts deleted on this BWG.

• Deleted Rate—Rate at which hosts are deleted.

Field Description

Field Description

Framed Routes Indicates the current number of unique framed routes downloaded from AAA and 
inserted into the IP routing table on a gateway.

Framed Router 
Subscribers

Indicates the number of subscribers using framed routes.

Auto-Provisioned 
Sessions

Indicates the number of auto-provisioned sessions on gateway.

Redirected 
Sessions

Indicates the number of sessions with all uplink IP packets redirected by the 
gateway.

Networks behind 
Mobile Stations

Indicates the number of networks behind mobile stations. 

Aged Out Hosts Count—Indicates the number of idle static hosts aged out.

Rate—Rate at which idle static hosts are aged out.
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Signaling Packet Statistics

The Signaling Packet Statistics pane shows:

DHCP Packet Statistics

The DHCP Packet Statistics pane shows:

Field Description

Pending • Count—Total number of signaling packets currently pending on this BWG

Processed • Count—Total number of signaling packets processed by this BWG.

• Rate—Rate at which signaling packets are processed.

Requeued • Count—Total number of signaling packets that were requeued on this BWG.

• Rate—Rate at which signaling packets are requeued.

Congestion Drops • Count—Number of signaling packets dropped when too many signaling 
packets are queued. The current queue limit is 1000 packets.

• Rate—Rate at which signaling packets are dropped.

Service Disabled 
Drops

• Count—Number of signaling packets dropped due to disabled service.

• Rate—Rate at which signaling packets are dropped.

Service Not Ready 
Drops

• Count—Number of signaling packets dropped while in non-active state for 
redundant configuration.

• Rate—Rate at which signaling packets are dropped.

Encapsulation 
Errors Drops

• Count—Number of signaling packets dropped due to encapsulation errors.

• Rate—Rate at which signaling packets are dropped.

Disposed Drops • Count—Number of signaling packets disposed by the BWG.

• Rate—Rate at which signaling packets are disposed.

Field Description

Discover • Count—Number of DHCP discover packets.

• Rate—Rate at which DHCP packets are discovered.

Offer • Count—Number of DHCP offer packets.

• Rate—Rate at which DHCP packets are offered.

Request • Count—Number of DHCP request packets.

• Rate—Rate at which DHCP packets are requested.

Decline • Count—Number of DHCP decline packets.

• Rate—Rate at which DHCP packets are declined.

Ack • Count—Number of DHCP acknowledged packets.

• Rate—Rate at which DHCP packets are acknowledged.

Nak • Count—Number of DHCP negatively acknowledged packets.

• Rate—Rate at which DHCP packets are negatively acknowledged.
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Handoff Statistics

The Handoff Statistics pane shows:

Release • Count—Number of DHCP release packets.

• Rate—Rate at which DHCP packets are released.

Inform • Count—Number of DHCP inform packets.

• Rate—Rate at which DHCP packets are informed.

Lease Query • Count—Number of DHCP lease query packets.

• Rate—Rate at which DHCP packets are lease queried.

Unknown • Count—Number of DHCP unknown packets.

• Rate—Rate at which DHCP packets are unknown.

Field Description

Field Description

Successful 
Handoffs

• Count—Number of successful session handoffs between Base Stations.

• Rate—Rate at which successful session handoffs occur.

Failed Handoffs • Count—Number of failed session handoffs between Base Stations.

• Rate—Rate at which failed session handoffs occur.

Successful CMAC 
Key Updates

• Count—Number of successful CMAC Key count updates related to handoff 
between base stations.

• Rate—Rate at which successful CMAC Key count updates are received.

Failed CMAC Key 
Updates

• Count—Number of failed CMAC Key count updates related to handoff 
between base stations.

• Rate—Rate at which failed CMAC Key count updates are received.

Successful Security 
Key Exchanges

• Count—Number of successful security key exchanges during handoff 
between base stations.

• Rate—Rate at which successful security key exchanges occur.

Failed Security Key 
Exchanges

• Count—Number of failed security key exchanges during handoff between 
base stations.

• Rate—Rate at which failed security key exchanges occur.
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Data Packet Statistics

The Data Packet Statistics pane shows:

Field Description

Received IP 
Packets

• Count—Number of data packets received by the BWG.

• Rate—Rate at which data packets are received by the BWG.

Received IP Bytes • Count—Number of data bytes received by the BWG.

• Rate—Rate at which data bytes are received by the BWG.

Sent IP Packets • Count—Number of data packets sent by the BWG.

• Rate—Rate at which data packets are sent by the BWG.

Sent IP Bytes • Count—Number of data bytes sent by the BWG.

• Rate—Rate at which data bytes are sent by the BWG.

Redirected IP 
Packets

• Count—Number of IP packets redirected by the BWG. 

• Rate—Rate at which IP packets are redirected by the BWG. 

Redirected IP Bytes • Count—Number of IP bytes redirected by the BWG. 

• Rate—Rate at which IP bytes are redirected by the BWG. 

Received Ethernet 
Packets

• Count—Number of ethernet packets received by the BWG. 

• Rate—Rate at which IP packets are redirected by the BWG.

Received Ethernet 
Bytes

• Count—Number of ethernet packets received by the BWG. 

• Rate—Rate at which ethernet packets are received by the BWG.

Sent Ethernet 
Packets

• Count—Number of ethernet packets sent by the BWG. 

• Rate—Rate at which ethernet packets are sent by the BWG. 

Sent Ethernet Byes • Count—Number of ethernet bytes sent by the BWG. 

• Rate—Rate at which ethernet bytes are sent by the BWG. 

Redirected Ethernet 
Packets

• Count—Number of ethernet packets redirected by the BWG. 

• Rate—Rate at which ethernet packets are redirected by the BWG.

Redirected Ethernet 
Bytes 

• Count—Number of ethernet bytes redirected by the BWG.

• Rate—Rate at which ethernet bytes are redirected by the BWG.

Punted Data 
Packets

• Count—Number data packets punted from the cef path to the process path. 

• Rate—Rate at which packets are punted from the cef path to the process 
path. 
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Dropped Packet Statistics

The Dropped Packet Statistics pane shows:

Field Description

Encapsulation 
Errors Drops

• Count—Number of data packets dropped due to encapsulation errors.

• Rate—Rate at which data packets are dropped.

Invalid Address 
Drops

• Count—Number of data packets dropped due to invalid IP address.

• Rate—Rate at which data packets are dropped.

Service Disabled 
Drops

• Count—Number of data packets dropped due to disabled service. 

• Rate—Rate at which data packets are dropped.

Invalid Protocol 
Type Drops

• Count—Number of data packets dropped due to invalid protocol types.

• Rate—Rate at which data packets are dropped.

Length Error Drops • Count—Number of data packets dropped due to IP packet length errors.

• Rate—Rate at which data packets are dropped.

Absent Key Drops • Count—Number of data packets dropped due to GRE key errors.

• Rate—Rate at which data packets are dropped.

Flow Not Found 
Drops

• Count—Number of data packets dropped due to flow not found errors.

• Rate—Rate at which data packets are dropped.

Flow Path Not 
Found Drops

• Count—Number of data packets dropped due to flow path not found errors.

• Rate—Rate at which data packets are dropped due to flow path not found 
errors. 

Flow Path Invalid 
Source Drops

• Count—Number of data packets dropped due to invalid source path address 
errors in the GRE header.

• Rate—Rate at which data packets are dropped due to invalid source path 
address errors in the GRE header.

Session Not Found 
Drops

• Count—Number of data packets dropped due to session not found errors for 
the GRE key.

• Rate—Rate at which data packets are dropped due to session not found 
errors. 

Subscriber Not 
Found Drops

• Count—Number of data packets dropped due to subscriber not found errors 
for the GRE key.

• Rate—Rate at which data packets are dropped due to subscriber not found 
errors.

Checksum Error 
Drops

• Count—Number of data packets dropped due to checksum errors.

• Rate—Rate at which data packets are dropped due to checksum errors.

Ingress Filtering 
Drops

• Count—Number of data packets dropped due to subscriber invalid source IP 
address errors.

• Rate—Rate at which data packets are dropped due to invalid source IP 
address errors. 
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Profile Statistics

The Profile Statistics pane shows:

Sequence Number 
Error Drops

• Count—Number of data packets dropped due to sequence number errors.

• Rate—Rate at which data packets are dropped due to sequence number 
errors.

Fragmented Drops • Count—Number of data packets dropped due to fragmented packet errors.

• Rate—Rate at which data packets dropped due to fragmented packet errors. 

Static IP Host 
Creation Failure 
Drops

• Count—Number of packets, such as upstream ARP and upstream data 
packets, dropped due to failure in creation of Static IP Host.

• Rate—Rate at which data packets are dropped due to failure in creation of 
Static IP Host. 

L2 Multicast and 
Broadcast Drops

• Number of L2 multicast and broadcast data packets other than ARP and 
DHCP dropped by BWG. 

• Rate—Rate at which L2 multicast and broadcast data packets are dropped. 

Throttled Path Punt 
Drops

• Count—Number of data packets dropped due to throttling of punts.

• Rate—Rate at which L2 multicast and broadcast data packets are dropped. 

Learned Static 
Hosts Drops

• Count—Number of data packets dropped due to BWG learning about static 
hosts from upstream data packets.

• Rate—Rate at which data packets are dropped due to BWG learning about 
static hosts from upstream data packets.

Field Description

Field Description

Service Flow 
Profile Not Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow profile. 

• Rate—Rate at which creation errors are received.

QoS Profile Not 
Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow QoS profile.

• Rate—Rate at which creation errors are received.

Classifier Profile 
Not Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow packet classifier profile.

• Rate—Rate at which service flow creation errors occur due to an 
unconfigured service flow packet classifier profile.

SLA Profile Not 
Found

• Count—Number number of session creation failures due to configuration 
error in Service Level Agreement (SLA) profile on BWG. 

• Rate—Rate at which session creation failures occur due to configuration 
error in Service Level Agreement (SLA) profile on BWG.
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Rejected Statistics

The Rejected Statistics pane shows:

Paths Statistics

Note For toolbar details, see Using the Toolbar, page 11-5.

The Paths statistics subtab shows information and statistics about each base station and contains:

Field Description

Rejected Base 
Station Paths 

• Count—Number of paths rejected because they exceeded the maximum 
number of base stations allowed to connect to this BWG.

• Rate—Rate at which paths are rejected because they exceeded the maximum 
number of base stations allowed to connect to this BWG.

Unapproved Base 
Station Sessions

• Count—Number of session creation and/or session handoffs rejected 
because the requesting base station is not approved for it.

• Rate—Rate at which created sessions and/or session handoffs are rejected 
because the base station is not approved for it. 

Rejected 
Subscriber Sessions

• Count—Number of sessions that were rejected due to exceeding the 
maximum number of allowed subscribers.

• Rate—Rate at which sessions that were rejected due to exceeding the 
maximum number of allowed subscribers. 

Rejected Session 
Flows

• Count—Number of flows that were rejected due to exceeding the        
maximum number of flows allowed per session.

• Rate—Rate at which flows were rejected due to exceeding the maximum 
number of flows allowed per session.

Session Deleted by 
the Gateway

• Count—Number of sessions deleted by the BWG.

• Rate—Rate at which sessions were deleted by the BWG. 

Rejected Hosts 
Open Requests

• Count—Number of hosts open requests rejected.

• Rate—Rate at which hosts open requests are rejected. 

Column Description

Remote IP Address Path IP address at the base station side.

Local IP Address Path IP address at the BWG side.

Type Path type, can be signaling or data.

Sessions Number of sessions over the path.

Flows Number of flows over the path.

Sent IP Packets 
Count

Total number of IP packets sent over the path.
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User Groups Statistics
The User Groups statistics subtab shows information and statistics for user groups and contains:

• Sessions and Flow Statistics, page 11-60

• Traffic Statistics, page 11-60

Note For toolbar details, see Using the Toolbar, page 11-5.

Sent IP Packets 
Rate

Rate at which IP packets are sent.

Sent IP Bits Count Total number of IP bits sent over the path.

Sent IP Bits Rate Rate at which IP bits are sent.

Received IP 
Packets Count

Total number of IP packets received over the path.

Received IP 
Packets Rate

Rate at which IP packets are received.

Received IP Bits 
Count

Total number of IP bits received over the path.

Received IP Bits 
Rate

Rate at which IP bits are received.

Sent Ethernet 
Packets Count

Total number of Ethernet packets sent over the path.

Sent Ethernet 
Packets Rate

Rate at which Ethernet packets are sent.

Sent Ethernet Bits 
Count

Total number of Ethernet bits sent over the path.

Sent Ethernet Bits 
Rate

Rate at which Ethernet bits are sent.

Received Ethernet 
Packets Count

Total number of Ethernet packets received over the path.

Received Ethernet 
Packets Rate

Rate at which Ethernet packets are received.

Received Ethernet 
Bits Count

Total number of Ethernet bits received over the path.

Received Ethernet 
Bits Rate

Rate at which Ethernet bits are received.

Column Description
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Sessions and Flow Statistics

The Sessions and Flow Statistics pane shows:

Traffic Statistics

The Traffic Statistics pane shows:

Column Description

Name Domain name identifying a user group.

Service Mode User group service mode.

Current Session: 
Count

Total number of active sessions per user group.

Sessions Created: 
Count

Total number of sessions created per user group.

Sessions Created: 
Rate

Rate at which sessions are created.

Sessions Deleted: 
Count

Total number of sessions deleted per user group.

Sessions Deleted: 
Rate

Rate at which sessions are deleted.

Flows Created: 
Count

Total number of active flows per user group.

Flows Created: 
Rate

Rate at which flows are created.

Flows Deleted: 
Count

Total number of flows created per user group.

Flows Deleted: 
Rate

Rate at which flows are deleted.

Group Overwrites: 
Count

Number of times this user group has been overwritten by user group received 
from the AAA server. Users can belong to a particular user group at the time of 
initial entry and the AAA server can recategorize the user under a different user 
group after successful authentication.

Group Overwrites: 
Rate

Rate at which this user group has been overwritten by user group received from 
the AAA server. 

Column Description

Name Domain name identifying a user group.

Service Mode User group service mode.

Sent IP Packets 
Count

Total number of IP packets sent over the path.

Sent IP Packets 
Rate

Rate at which IP packets are sent.

Sent IP Bits Count Total number of IP bits sent over the path.
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Sent IP Bits Rate Rate at which IP bits are sent.

Received IP 
Packets Count

Total number of IP packets received over the path.

Received IP 
Packets Rate

Rate at which IP packets are received.

Received IP Bits 
Count

Total number of IP bits received over the path.

Received IP Bits 
Rate

Rate at which IP bits are received.

Sent Ethernet 
Packets Count

Total number of Ethernet packets sent over the path.

Sent Ethernet 
Packets Rate

Rate at which Ethernet packets are sent.

Sent Ethernet Bits 
Count

Total number of Ethernet bits sent over the path.

Sent Ethernet Bits 
Rate

Rate at which Ethernet bits are sent.

Received Ethernet 
Packets Count

Total number of Ethernet packets received over the path.

Received Ethernet 
Packets Rate

Rate at which Ethernet packets are received.

Received Ethernet 
Bits Count

Total number of Ethernet bits received over the path.

Received Ethernet 
Bits Rate

Rate at which Ethernet bits are received.

Received: Packets 
Rate

Rate at which packets are received.

Received: Bits 
Count

Total number of bits received by this user group.

Received: Bits Rate Rate at which bits are received.

Invalid Source 
Packets: Count

Number of packets dropped due to invalid source address errors.

Invalid Source 
Packets: Rate

Rate at which packets are dropped.

Invalid Source Bits: 
Count

Number of bits dropped due to invalid source address errors.

Invalid Source Bits: 
Rate

Rate at which bits are dropped.

Column Description
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Displaying HA Real-Time Statistics
The MWTM enables you to display real-time statistics for Home Agent (HA) nodes in the MWTM web 
interface. To display HA real-time statistics, select a HA node in the navigation tree and click the 
Statistics tab. These subtabs appear:

• Global, page 11-62

• IP Local Pool Config, page 11-64

• IP Local Pool Stats, page 11-64

Global
The Global subtab shows global statistics for HA nodes and contains:

• Registrations Processed by AAA

• Registration Requests

• Standby Synchronization

Note For toolbar details, see Using the Toolbar, page 11-5.

Registrations Processed by AAA

The Registrations Processed by AAA pane shows:

Field Description

Maximum 
Processed in one 
minute

The maximum number of registration requests processed in a minute by the HA. 
It includes only those registration requests which were authenticated by the AAA 
server.

Average time to 
process (msecs)

The average time taken by the home agent to process a registration request. 
Calculations are based on only those registration requests that were authenticated 
by the AAA server.

Authenticated via 
AAA Server

• Count—The total number of registration requests processed by the home 
agent, including only those registration requests that were authenticated by 
the AAA server. 

• Rate—The total rate of registration requests processed by the home agent, 
including only those registration requests that were authenticated by the 
AAA server.
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Registration Requests

The Registration Requests pane shows:

Standby Synchronization

The Standby Synchronization pane shows:

Field Description

Current Bindings • Count—The current number of entries in the home agent’s mobility binding 
list. The home agent updates this number in response to registration events 
from mobile nodes.

• Rate—The count can increment or decrease, resulting in a positive or 
negative rate.

Initial Received • Count—Total number of initial registration requests received by the HA.

• Rate—Rate at which initial registration requests are received by the HA.

Initial Denied • Count—Total number of initial registration requests denied by the HA.

• Rate—Rate at which initial registration requests are denied by the HA.

All Received • Count—Total number of all registration requests received by the HA.

• Rate—Rate at which all registration requests are received by the HA.

All Denied • Count—Total number of all registration requests denied by the HA.

• Rate—Rate at which all registration requests are denied by the HA.

Field Description

Binding Updates 
Sent

• Count—Total number of binding updates sent by the home agent to a standby 
home agent.

• Rate—Total rate of binding updates sent by the home agent to a standby 
home agent.

Binding Updates 
Unacknowledged

• Count—Total number of binding updates sent by the home agent for which 
no acknowledgement is received from the standby home agent.

• Rate—Total rate of binding updates sent by the home agent for which no 
acknowledgement is received from the standby home agent.
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IP Local Pool Config

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Config subtab shows IP addresses for HA nodes and contains:

IP Local Pool Stats

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for HA nodes and contains:

Column Description

Name Name that uniquely identifies an IP local pool. This name must be unique among 
all the local IP pools even when they belong to different pool groups.

Low This object specifies the first IP address of the range of IP addresses contained 
by this pool entry. This address must be less than or equal to the High address.

High This object specifies the last IP address of the range of IP addresses mapped by 
this pool entry. If only a single address is being mapped, the value of this object 
is equal to the Low value.

Free The number of IP addresses available for use in the range of IP addresses.

In Use The number of IP addresses being used in the range of IP addresses.

Priority This object specifies the priority of the IP local pool. IP local pools will be used 
in assigning IP addresses in the order of priority.

Column Description

Name Name that uniquely identifies an IP local pool. This name must be unique among 
all the local IP pools even when they belong to different pool groups.

Free The number of IP addresses available for use in this IP local pool.

In Use The number of IP addresses being used in this IP local pool.

Maximum In Use Contains the high water mark of used addresses in an IP local pool since pool 
creation, since the system was restarted, or since this object was reset, whichever 
occurred last.

Low Threshold When the number of used addresses in an IP local pool falls below this threshold 
value, a notification is generated.

High Threshold When the number of used addresses in an IP local pool is equal or exceeds this 
threshold value, a notification is generated.

Low Threshold 
Percentage

When the percentage of used addresses in an IP local pool falls below this 
threshold value, a notification is generated. 

High Threshold 
Percentage

When the percentage of used addresses in an IP local pool is equal or exceeds 
this threshold value, a notification is generated. 
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Displaying GGSN Real-Time Statistics
The MWTM enables you to display real-time statistics only in the MWTM web interface for Gateway 
GPRS Support Nodes (GGSNs) that reside on the Service and Application Module for IP (SAMI). To 
display GGSN real-time statistics, select a SAMI-based GGSN node in the navigation tree and click the 
Statistics tab. These subtabs appear:

• Global, page 11-65

• SGSN Throughput, page 11-68

• APN General, page 11-69

• APN Throughput Statistics, page 11-70

• IP Local Pool Config, page 11-71

• IP Local Pool Stats, page 11-72

Global

Note For toolbar details, see Using the Toolbar, page 11-5.

The Global subtab shows global statistics for GGSN nodes and contains:

• GTP Statistics, page 11-65

• Charging Statistics, page 11-66

• GTP Throughput Statistics, page 11-66

• PDP Context Statistics, page 11-66

• AAA Statistics, page 11-68

• IP and UDP Statistics, page 11-68

GTP Statistics

The GTP Statistics pane displays statistics about the GPRS Tunneling Protocol (GTP) and contains:

Column Description

GTP Signaling 
Messages

GTP signaling messages sent between the Serving GPRS Support Node (SGSN) 
and GGSN.

G-PDU Messages GTP Packet Data Unit (G-PDU) messages received on an SGSN path.

G-PDU Octets Bytes sent and received in a GTP PDU message on an SGSN path.

Sent Count—The number of messages or bytes in the transmit direction.

Rate—The transmit rate of the messages or bytes.

Received Count—The number of messages or bytes in the receive direction.

Rate—The receive rate of the messages or bytes.
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Charging Statistics

The Charging Statistics pane displays count and rate statistics for GGSN charging messages and 
contains:

GTP Throughput Statistics

The GTP Throughput Statistics pane displays count and rate statistics about GTP throughput and 
contains:

PDP Context Statistics

The PDP Context Statistics pane shows count and rate values for these statistics:

Column Description

G-CDR Messages 
Pending

GGSN Call Detail Records (CDRs) that are pending.

G-CDR Messages 
Sent

G-CDRs that were sent.

Column Description

GTP Packets GTP packets between the GGSN and SGSN.

GTP Bytes GTP bytes between the GGSN and SGSN.

Sampling Interval 
in Minutes: 3

Global GTP throughput statistics on the GGSN for a duration of 3 minutes.

Sampling Interval 
in Minutes: 5

Global GTP throughput statistics on the GGSN for a duration of 5 minutes. 

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Upstream Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream Rate (per second) of downstream GTP traffic during the last sampling period.

Column Description

Active GTP v0 PDP 
Contexts 

PDP contexts (GTP version 0) that are active.

Active GTP v1 PDP 
Contexts 

PDP contexts (GTP version 1) that are active.

PDP Contexts 
Created 

PDP contexts that were created.

PDP Contexts 
Deleted

PDP contexts that were deleted.

PDP Activations 
Rejected

PDP contexts for which the activation request was rejected.
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PDP Requests 
Dropped 

Create PDP context requests and delete PDP context requests that were dropped 
because the threshold limit was reached for the maximum number of 
Point-to-point (PPP) regeneration sessions allowed on the GGSN.

PDP PPP-Regen 
Interfaces Created 

Device-specific interfaces created for association with PDP contexts regenerated 
to a PPP session.

Active PDP 
Contexts with 
Direct Tunnel 

Active PDP contexts with direct tunnel enabled.

PDP Contexts 
Deleted Without 
Waiting for the 
SGSN

PDPs deleted in the GGSN without waiting for a delete context response from 
the SGSN.

PDP Contexts 
Deleted Without 
Sending to the 
SGSN

PDPs deleted in the GGSN without sending a delete request to the SGSN.

Update PDP 
Context Requests 
Sent 

Update PDP context requests that the GGSN initiated and that were sent to the 
SGSN.

Update PDP 
Context Responses 
Received 

Update PDP context responses received from the SGSN for the GGSN-initiated 
update requests.

COA Messages 
Received 

Change of Authorization (COA) messages received at the GGSN.

COA Messages 
Dropped 

COA messages dropped at the GGSN.

COA QOS Updates 
Sent 

Update PDP requests for QOS changes that COA initiated and that are sent from 
the GGSN.

Error Indication 
Messages Received 

Error indication messages received on the GGSN.

Direct Tunnels 
Enabled 

Direct tunnels enabled for the PDP contexts in the GGSN.

Error Indications 
for DT PDP 
Contexts 

Error indications received for Direct Tunnel (DT) PDP contexts from the Radio 
Network Controller (RNC).

DT PDP Contexts 
Deleted Due to 
Update Response 

Direct tunnel PDP contexts deleted because of update response failure.

Column Description
11-67
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 11      Accessing Data from the Web Interface
  Displaying GGSN Real-Time Statistics
AAA Statistics

The AAA Statistics pane shows:

IP and UDP Statistics

The IP and UDP Statistics pane shows:

SGSN Throughput

Note For toolbar details, see Using the Toolbar, page 11-5.

The SGSN Throughput subtab shows:

Column Description

AAA Server Name Name of the Authentication, Authorization, and Accounting (AAA) server.

Server State Whether the server is up (operational) or down (not operational).

Authentication 
Requests

Count and rate values for requests to the AAA server for authentication.

Accounting 
Requests

Count and rate values for requests to the AAA server for accounting services.

Column Description

IP In Header Errors Input datagrams discarded because of errors in their IP headers, including bad 
checksums, version number mismatches, other format errors, time-to-live 
exceeded, and errors discovered in processing their IP options.

IP Out Discards Outbound packets that were discarded although no errors were detected. One 
reason for discarding a packet would be to free buffer space.

IP Out No Routes IP datagrams discarded because no route could be found to transmit them. This 
statistic includes any datagrams that a host cannot route because all its default 
gateways are down.

IP Reassembly 
Fails 

Failures detected by the IP reassembly algorithm.

IP Routing 
Discards 

Routing entries that were discarded even though they are valid. One reason for 
discarding a routing entry would be to free buffer space for other routing entries.

UDP In Datagrams UDP datagrams delivered to UDP users.

Column Description

SGSN Name Name of the SGSN.

Sampling Interval 
in Minutes: 3

Throughput statistics on the SGSN for a duration of 3 minutes. 
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APN General

Note For toolbar details, see Using the Toolbar, page 11-5.

The APN General subtab contains:

• APN Miscellaneous Statistics, page 11-69

• APN PDP Context Statistics, page 11-70

• APN Throughput Statistics, page 11-70

APN Miscellaneous Statistics

To view the APN Miscellaneous Statistics table, choose this option from the Type drop-down menu. The 
GUI displays count and rate values for these statistics:

Sampling Interval 
in Minutes: 5

Throughput statistics on the SGSN for a duration of 5 minutes. 

Upstream Packets Rate (per second) of upstream packets sent on this SGSN during the last sampling 
period.

Upstream Bytes Rate (per second) of upstream bytes sent on this SGSN during the last sampling 
period.

Downstream 
Packets

Rate (per second) of downstream packets sent on this SGSN during the last 
sampling period.

Downstream Bytes Rate (per second) of downstream bytes sent on this SGSN during the last 
sampling period.

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Column Description

Column Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Upstream Payload 
Volume

The total payload volume in upstream traffic.

Downstream 
Payload Volume

The total payload volume in downstream traffic.

Source Address 
Violations

Upstream Transport PDUs (T-PDUs) that have been dropped because of source 
address violations.

COA Messages 
Received

COA messages received on this APN. 
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APN PDP Context Statistics

To view the APN PDP Context Statistics table, choose this option from the Type drop-down menu. The 
GUI displays the count and rate values for these statistics:

APN Throughput Statistics

To view the APN Throughput Statistics table, choose this option from the Type drop-down menu. The 
GUI displays the count and rate values for these statistics:

COA Messages 
Acknowledged

COA messages that were acknowledged by the GGSN with a COA ACK. 

Direct Tunnels 
Enabled

Direct tunnels enabled for the PDP contexts on this APN.

Column Description

Column Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

PDP Activations 
Initiated by MS

PDP context activation procedures initiated by any mobile station (MS) on this 
APN.

PDP Activations 
Completed by MS

Successfully completed PDP context activation procedures initiated by MS on 
this APN.

PDP Deactivations 
Initiated by MS

PDP context deactivation procedures initiated by the MS on this APN.

PDP Deactivations 
Completed by MS

Successfully completed PDP context deactivation procedures initiated by the 
MS.

PDP Deactivations 
Initiated by GGSN

PDP context deactivation procedures initiated by the GGSN.

PDP Deactivations 
Completed by 
GGSN

Successfully completed PDP context deactivation procedures initiated by the 
GGSN.

Active PDP 
Contexts

Active PDP contexts in the APN.

Update PDP 
Context Requests 
Sent

GGSN-initiated update requests sent on this APN.

Update PDP 
Context Responses 
Received

Successful update responses received from the SGSN with a cause value of 
Request accepted for the GGSN-initiated update requests on this APN.

Column Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.
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IP Local Pool Config

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Config subtab shows IP addresses for GGSN nodes and contains:

Sampling Interval 
in Minutes: 3

Throughput statistics on the APN for a duration of 3 minutes. 

Sampling Interval 
in Minutes: 5

Throughput statistics on the APN for a duration of 5 minutes. 

Upstream Packets Rate (per second) of upstream packets sent on this APN during the last sampling 
period.

Upstream Bytes Rate (per second) of upstream bytes sent on this APN during the last sampling 
period.

Downstream 
Packets

Rate (per second) of downstream packets sent on this APN during the last 
sampling period.

Downstream Bytes Rate (per second) of downstream bytes sent on this APN during the last sampling 
period.

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Column Description

Column Description

Name Name of the IP local pool.

Addresses Low—The first IP address of the range of IP addresses contained by this pool 
entry.

High—The last IP address of the range of IP addresses mapped by this pool entry.

Free—The number of IP addresses available for use within the range of IP 
addresses.

In Use—The number of IP addresses being used within the range of IP addresses.
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IP Local Pool Stats

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for GGSN nodes and contains:

Displaying PWE3 Real-Time Statistics
The MWTM enables you to display PWE3 real-time statistics in the MWTM web interface. Because the 
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar, 
the PWE3 real-time statistics are described in Viewing PWE3 Statistics, page 8-121. 

Displaying TDM Real-Time Statistics
The MWTM enables you to display TDM real-time statistics in the MWTM web interface. Because the 
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar, 
the TDM real-time statistics are described in Viewing TDM Statistics, page 8-103. 

Column Description

Name Name of the IP local pool.

Addresses Free—The number of IP addresses available for use in this IP local pool.

In Use—The number of IP addresses being used in this IP local pool.

Maximum in Use—The maximum number of used addresses in an IP local pool 
since pool creation, since the system was restarted, or since this object was reset, 
whichever occurred last.
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